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ABSTRACT

This report describes a Graphical-User Interface (GUI) developed for 
MODFLOW-96, the latest revision of the U.S. Geological Survey (USGS) modular, three- 
dimensional, finite-difference ground-water flow model. The pre- and post­ 
processing GUI's for MODFLOW-96 were developed as Plug-In Extensions (PIEs) to the 
commercially available software developed by Argus Interware. The Argus Interware 
product, known as Argus Numerical Environments (ArgusNE), is a programmable 
geographic information system (GIS) that has automated gridding and meshing 
capabilities to link geospatial information with finite-difference and finite-element 
discretization, as well as several means of importing geospatial information. The pre- 
and post-processing interfaces automate the use of ArgusNE to create the appropriate 
GIS coverages or layers for MODFLOW-96 automatically, and to install menus and 
dialogs to synthesize geospatial information and simulation control parameters for 
MODFLOW-96, as well as visualize the model results. In addition to the Basic, Block- 
Centered Flow and Output Control packages of MODFLOW-96, the preprocessing GUI 
also incorporates the river, drain, well, general-head boundary, recharge and 
evapotranspiration packages, as well as four matrix solution algorithms. The 
preprocessing GUI creates formatted ASCII files that can be read by MODFLOW-96. 
MODFLOW-96 can be executed within the ArgusNE application, and hydraulic head 
and drawdown results from MODFLOW-96 simulations can be visualized with the 
postprocessing GUI. The GUI for MODFLOW-96 discussed in this report is a fully 
functioning graphical pre- and post-processor; however, it also allows the user to 
apply programmable features within ArgusNE to tailor the GUI to meet the unique 
demands of the each ground-water modeling project.

INTRODUCTION

Numerical models can not be regarded as representations of the real world 
because the complexity of natural hydrogeologic systems can never be captured in 
the discretized parameters of a numerical model. Instead, numerical modeling should 
be viewed as a means of testing hydrologic hypotheses based on model parameters 
that best represent measured phenomena. However, testing hydrologic hypotheses 
often becomes time consuming because numerical models have complex data 
requirements. To facilitate the modeling process, graphical-user interfaces (GUI's) 
are needed to synthesize geospatial information and simulation control parameters, 
as well as visualize the simulated results.

This report describes a GUI developed for MODFLOW-96, the latest revision of 
the U.S. Geological Survey (USGS) modular, three-dimensional, finite-difference 
ground-water flow model (Harbaugh and McDonald, 1996a; 1996b). Attributes of 
MODFLOW-96 as compared to earlier versions of MODFLOW are discussed in Harbaugh 
and McDonald (1996a).



The GUI for MODFLOW-96 discussed in this report is developed using 
commercially available software developed by Argus Interware. The Argus Interware 
product, known as Argus Numerical Environments (ArgusNE), is a programmable 
geographic information system (CIS) that has automated gridding and meshing 
capabilities to link geospatial information with finite-difference and finite-element 
discretization, as well as several means of importing geospatial information. The 
programmable nature of ArgusNE allows geospatial information and simulation 
control parameters to be exported to ASCII files that can be read by the numerical 
model, in this case, MODFLOW-96. In addition, ArgusNE allows access to externally 
developed Plug-In Extensions (PIEs), which are executable codes loaded into the 
memory of ArgusNE such that they appear as part of ArgusNE, even though they 
have been developed independently (Argus Interware, 1997b). For example, PIEs can 
be developed for purposes such as spatial interpolation, grid and mesh generation, 
geostatistics and control of model pre- and post-processing.

Although ArgusNE operates on multiple computing platforms, the GUI for 
MODFLOW-96 has been developed for computers operating under the Windows 3.11, 
Windows 95 and Windows NT operating systems. The GUI consists of two PIEs that 
appear as the files MFGUI_10.DLL and MFPOST10.DLL. The file extension DLL is 
referred to as a dynamically linked library, which is the name of the Microsoft 
technology that allows external codes to be loaded in the memory of software 
applications. The file MFGUI_10.DLL is the preprocessor for MODFLOW-96, and 
MFPOST10.DLL is the postprocessor for visualizing hydraulic head and drawdown 
solutions generated from MODFLOW-96 simulations. These PIEs are available without 
charge from the U.S. Geological Survey and can be distributed freely, however, they 
require an executable version of ArgusNE (version 3.0 revision s or higher) to 
operate. Furthermore, the PIEs described in this report are referred to as version 1, 
as enhancements in these codes are anticipated as users' needs are evaluated.

Although the GUI for MODFLOW-96 discussed in this report is a fully 
functioning graphical pre- and post-processor, it also allows the user to apply 
programmable features within ArgusNE to meet the unique demands of the each 
modeling project. Thus, the GUI for MODFLOW-96 is intended as a structure from 
which the user can add capability according to the demands of the modeling project.

This report is intended as a description of the use of the PIEs as graphical pre- 
and post-processors for MODFLOW-96. This report is not intended as a description of 
the programming that has been used to develop the PIEs ; however, the source codes 
for the PIEs (developed with Microsoft Visual C++) are available for those who wish to 
modify or augment the graphical pre- and post-processing capability developed in 
this version. Furthermore, it is assumed that the reader has a knowledge of the basic 
data requirements and underlying principles for using the USGS modular, three- 
dimensional, finite-difference, ground-water flow model. McDonald and Harbaugh 
(1988) and Harbaugh and McDonald (1996a, 1996b) provide thorough discussions of 
principles underlying MODFLOW-96. In addition, it is assumed that the reader has a 
knowledge of the general attributes and use of ArgusNE. Information about ArgusNE 
can be obtained from the ArgusNE User's Guide (Argus Interware, 1997a) and the 
World-Wide Web site for Argus Interware (http://www.argusint.com).



SYSTEM REQUIREMENTS AND INSTALLATION

The pre- and post-processing GUI developed for MODFLOW-96 and described in 
this report uses Argus Numerical Environments (ArgusNE) version 3.0 (revision s). 
More recent versions of ArgusNE also are compatible with the GUI for MODFLOW-96. 
ArgusNE operates on multiple computing platforms, however, the GUI discussed in 
this report has been developed only for computers operating under Windows 3.11, 
Windows 95 and Windows NT. Optimal operation of ArgusNE requires a Pentium 100 
Mhz processor with 16 MB of RAM, 7 MB of free disk space and a video card capable of 
displaying 256 colors; however, capability to use 65,000 colors is recommended.

The pre- and post-processing GUI for MODFLOW-96 consists of four files, 
MFGUI_10.DLL and MFPOST10.DLL , MODFLOW.MET and MODFLOW.VAL. The file 
MFGUI_10.DLL is the PIE associated with preprocessing of simulation controls and 
geospatial information for MODFLOW-96. The fileMFPOST10.DLL is the PIE associated 
with postprocessing visualization of hydraulic head and drawdown solutions from 
MODFLOW-96. The file MODFLOW.MET is the ArgusNE export template used with 
MFGUI_10.DLL to export simulation control and geospatial information into ASCII 
files that are read by MODFLOW-96. The file MODFLOW.VAL consists of default values 
for simulation control parameters used with MFGUI_10.DLL.

The pre- and post-processing PIEs for MODFLOW-96 have been developed using 
Microsoft Visual C++. The source codes for the PIEs are available at the World-Wide 
Web site http://water.usgs.gov/software/ along with the files discussed above; 
this information is included under the category Ground Water. Additional 
information about ArgusNE can be found on the World-Wide Web site 
http://www.argusint.com.

To use the pre- and post-processing PIEs for MODFLOW-96 with ArgusNE, the 
files MFGUI_10.DLL and MFPOST10.DLL , MODFLOW.MET and MODFLOW.VAL must be 
placed in the directory ArgusPIE (or within a directory in the ArgusPIE directory) 
under the ArgusNE application. ArgusNE searches the ArgusPIE directory upon 
being launched and loads those PIEs that it encounters.

The executable version of MODFLOW-96 (MODFLW96.EXE) is assumed to be 
located in a directory with the pathname C:\MODFLW96.3_1; the full pathname of the 
executable for MODFLOW-96 is assumed to be C:\MODFLW96.3_1\MODFLW96.EXE. If the 
executable version of MODFLOW-96 is located in another directory, the MODFLOW.MET 
file in the ArgusPIE directory must be edited using a text editor that can save files in 
an ASCII format. The pathname of the executable version of MODFLOW-96 is given in 
the second line from the bottom of the file. This line currently reads:

Execute external code: M C:\MODFLW96.3_1\MODFLW96.EXEM

The pathname in quotation marks should be replaced with the full pathname of the 
executable version of MODFLOW-96.



LAUNCHING THE PREPROCESSOR AND SAVING PROJECT INFORMATION
The preprocessing PIE for MODFLOW-96 automates the use of ArgusNE to create 

the appropriate CIS coverages or layers for MODFLOW-96 automatically and install 
menus and dialogs specific to MODFLOW-96 that can be invoked from within the 
ArgusNE application.

With the files MFGUI_10.DLL, MODFLOW.MET and MODFLOW.VAL in the ArgusPIE 
directory, launching ArgusNE will automatically load the PIE needed to launch the 
preprocessing interface for MODFLOW-96. After launching ArgusNE, the MODFLOW-96 
preprocessor is launched by selecting the New MODFLOW Project menu item from 
the File menu . The MODFLOW-96 Preprocessor dialog box shown in Figure 1 appears 
on the screen. This dialog box is composed of a series of tab-dialog boxes in which 
project information is entered for MODFLOW-96 simulations. The titles of the tab 
dialog boxes are:

Project
Geology
Misc. Controls
Stresses/Solvers
Time
Output Files
Output Controls
Solver (where Solver is one of the following, PCG, SOR, DE4, or SIP)

The Project Information dialog boxes are used to enter simulation control 
parameters and other nonspatial information. Geospatial information, such as the 
spatial distribution of physical parameters, is created or imported in geospatial 
information layers, which will be described in a subsequent section.

The cursor is used to move from one tab dialog box to the next by clicking the 
tab of the desired dialog box. After information is entered into the tab dialog boxes, 
clicking the OK button prepares the set of geospatial information layers prescribed 
in the MODFLOW-96 Preprocessor that are to be used in the MODFLOW-96 simulation; 
control is then returned to the ArgusNE application. Clicking the Cancel button 
ignores any changes made in the tab-dialog boxes. The OK or Cancel button can be 
clicked at any time while editing project information for the MODFLOW-96 simulation; 
it is not necessary to access all of the tab dialog boxes before using the OK or Cancel 
buttons. Existing information in the MODFLOW-96 Preprocessor tab dialog boxes can 
be edited using the Edit Project Info menu item in the Edit menu, which causes 
the tab-dialog boxes to appear on the screen where information can again be entered 
and edited.

The project information for the MODFLOW-96 simulations as well as any 
information entered into the geospatial information layers in the ArgusNE 
application is saved by using the Save or Save As... command in the File menu. 
Launching ArgusNE application and opening an existing file containing MODFLOW- 
96 simulation information will retrieve the project information in the MODFLOW-96 
Preprocessor tab dialog boxes and the geospatial information that was entered 
previously.



Figure 1. MODFLOW-96 preprocessor dialog box.

ENTERING AND EDITING INFORMATION IN THE MODFLOW-96 PREPROCESSOR

Geospatial information such as the spatial distribution of physical parameters 
is entered into geospatial information layers as described in the Geospatial 
Information Layers section of this report. The MODFLOW-96 Preprocessor dialog boxes 
are used to enter simulation control parameters and other nonspatial information.

To enter project information for a MODFLOW-96 simulation, the MODFLOW-96 
preprocessor is launched from the File menu by choosing New MODFLOW Project. 
For an existing project saved in an ArgusNE file, the preprocessor information is 
edited from the Edit menu by choosing Edit Project Info. Either method causes the 
MODFLOW-96 Preprocessor dialog boxes to appear on the screen. The information in 
these dialog boxes is synthesized to build the structure of geospatial information 
layers needed for the MODFLOW-96 simulation. In the following, the information in 
each of the preprocessor dialog boxes is described.

Project Dialog

Information related to the description of the simulation is entered in the 
Project tab dialog box (Figure 1). The Project Name, Date and Description are editable 
fields used to describe the simulation. This information is not exported to the files 
used by MODFLOW-96; it is stored in an ArgusNE file and is provided as a convenience 
for archiving model information.

The two editable fields at the bottom of the Project dialog box entitled Project 
title are exported to the ASCII files read by MODFLOW-96.



Geology Dialog

The information in the Geology tab dialog box (Figure 2) defines the basic 
geologic structure of the three-dimensional modeled domain. In this dialog box, the 
number of geologic units in a simulation is defined and attributes for these geologic 
units are specified. Here, it is important to note that a distinction is made between 
geologic units and model layers. A geologic unit may consist of one or more model 
layers. Geospatial properties of geologic units are assumed to be constant over the 
thickness of a given geologic unit, however, these properties may vary in the area! 
dimensions; a discussion of geospatial information for MODFLOW-96 simulations is 
discussed in the following section.
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Figure 2. Geology dialog in MODFLOW-96 preprocessor.

The defaults for the Geology tab dialog box assume 3 geologic units, referred to 
as Top Aquifer, Aquitard and Bottom Aquifer. The names and attributes of these 
geologic units can be edited, by using the editable fields at the bottom of the dialog 
box and the Modify button at the right of the dialog box. Geologic units also can be 
added and deleted by using the Insert and Delete buttons at the right of the dialog 
box.

The order of the geologic units in the table is assumed to be the exact physical 
sequence that is to be modeled. The top of the simulated sequence is associated with 
geologic unit 1, and lower geologic units in the sequence are denoted by unit 2, unit 
3, and so forth, for as many geologic units as exist.



Editing Attributes of Geologic Units

To edit attributes associated with a given geologic unit, click the desired 
geologic unit in the table. The current attributes of that geologic unit will be placed 
in the editable fields at the bottom of the dialog box. Modifications to the attributes of 
the geologic unit are made in the editable fields at the bottom of the dialog box. 
Clicking the Modify button accepts the changes made in the editable fields and these 
changes are entered in the table at the top of the dialog box.

Deleting a Geologic Unit

To delete a geologic unit from the list, the cursor is moved to the table listing 
the geologic units. Clicking the row in the table highlights the information and then 
clicking the Delete button removes the geologic unit from the list. The remaining 
geologic units are renumbered. It is important to note that deleting a geologic unit 
will delete the geospatial information layers and all information in those layers. This 
information will be deleted once the OK button is clicked; clicking the Cancel button 
will cancel changes made in the dialog boxes. If the attributes and the geospatial 
information of the geologic unit may be needed at a later time, to avoid entering or 
importing this information again, the project information should be saved to another 
filename by first exiting the dialog boxes and using the Save As... command in the 
File pull-down menu.

Adding a Geologic Unit

To add a geologic unit, the cursor is moved to the table listing the geologic 
units and a row is select by clicking on it. Clicking the Insert button adds a geologic 
unit below the highlighted geologic unit. Attributes associated with the selected 
geologic unit are copied to the new geologic unit. The geologic units are then 
renumbered to reflect the addition of the new geologic unit.

Attributes of Geologic Units

Number is the sequence number of the geologic unit. The sequence number is 
assigned by the order of the geologic units, where the top most geologic unit is unit 1. 
The sequence number is not an editable attribute of the geologic unit, it can be 
changed only by inserting or deleting geologic units.

Name is the name of the geologic unit. This field is only intended for 
descriptive purposes. Geospatial information will be referenced to the sequence 
number (Unit 1, Unit 2 and so forth), not the name of the geologic unit.

Simulated is a flag indicating whether the geologic unit is to be simulated or 
not. Simulating the geologic unit implies that a hydraulic head solution will be 
achieved in the model layers of that geologic unit. Not simulating a geologic unit 
implies that the geologic unit is treated as a semi-confining unit and quasi-steady 
vertical flow is assumed to exist through that unit. Under such an assumption, a 
hydraulic head solution is not generated for the nonsimulated unit, however, 
hydraulic and topographic properties (in particular, the vertical hydraulic 
conductivity and top and bottom elevations) of that unit are used in preparing the 
information needed to solve for the hydraulic heads in the adjacent simulated 
geologic units. More than one nonsimulated geologic unit can be placed between



simulated geologic units. If nonsimulated geologic units are located at the top or 
bottom of the sequence of geologic units, they do not effect the solution for hydraulic 
head in the simulated geologic units in between.

For a nonsimulated geologic unit, only the vertical hydraulic conductivity and 
top and bottom elevation of the unit are used in generating information that is 
eventually exported for executing MODFLOW-96. Entering or importing this 
information will be described in detail in the following section. However, other 
geospatial information can be stored in the other geospatial information layers of a 
nonsimulated geologic unit in the event that the nonsimulated geologic unit will be 
changed to a simulated geologic unit.

Interblock Transmissivity is the method of computing the interblock 
transmissivity in a given geologic unit. A pop-up menu provides the choices for this 
parameter, which are harmonic mean, arithmetic mean, logarithmic mean and 
arithmetic mean of saturated thickness and logarithmic mean of transmissivity. (For 
the last option, the Matrix Storage parameter in the Misc. Controls dialog box 
discussed below must be set so that the storage in the arrays BUFF and RHS is 
separate.) More information about the choices for interblock transmissivity is 
provided in Goode and Appel (1992) and Harbaugh and McDonald (1996a, 1996b).

Aquifer Type is the type of aquifer (confined, unconfined or convertible) for 
the geologic unit. Only the uppermost simulated geologic unit can be an unconfined 
aquifer. For an unconfined geologic unit that is divided into more than one model 
layer, the top layer is assumed to be unconfined and subsequent layers are assumed to 
be convertible model layers. More information about the choices for aquifer type is 
provided in Harbaugh and McDonald (1996a, 1996b).

Anisotropy Factor is the ratio of hydraulic conductivity in the y-direction to 
the hydraulic conductivity in the x-direction of the modeled domain. A value of 1 
implies an isotropic hydraulic conductivity.

Vertical Discretization is the number of model layers associated with the 
geologic unit. The model layers are assumed to be equally spaced in the vertical 
direction. The thickness of the geologic unit can vary in the area! dimensions, 
however, at a given areal location the thickness of the geologic unit is divided into 
equally spaced model layers in the vertical direction.

Modeling Geologic Units That Are Not Areally Extensive

The conceptual model of a sequence of geologic units implicitly assumes that 
geologic units are areally extensive in the modeled domain. Geologic units that are 
not areally extensive can also be modeled. To model geologic units that pinch out, a 
conceptual picture similar to that shown in Figure 3 must be used; Figure 3 is a cross 
section of a series of geologic units, where one of the units pinches out. A geologic 
unit that pinches out is assumed to be areally extensive with a finite thickness at all 
points in the areal dimensions; however the hydraulic properties of the geologic unit 
are made to vary in the areal dimensions to reflect the pinching out of the geologic 
unit.
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Geologic Unit 1

Geologic Unit 2

Geologic Unit 3

Figure 3. Schematic diagram of a geologic unit that is not areally 
extensive.

Misc. Controls Dialog

In the Misc. Controls tab dialog (Figure 4), control information used in 
MODFLOW-96 simulations is specified. The control information is entered directly in 
the editable fields or from options provided in pop-up menus.

MODFLOW DataSets

| Initial Heads are not kept (0) j*J

;[HNOFU3|

MeicJM^i^dfoPftCelsc 1-999999 - - =^. **- p

| BUFF, RHS occupy same space (0)

[Wetting Capability Inactive (0)

BOT+WETFCT[WETDRY)(1

Figure 4. Misc. Controls dialog in MODFLOW-96 preprocessor.

In the upper half of the dialog box, several of the control parameters Basic 
Package of MODFLOW-96 are specified. Harbaugh and McDonald (1996a, 1996b) 
provide additional information about the definition of these control parameters.



Matrix Storage defines storage locations for arrays in MODFLOW-96. Two 
options are provided in the pop-up menu; the vectors "BUFF, RHS occupy the same 
storage space" or "BUFF, RHS occupy different storage space." If the interblock 
transmissivity for any of the geologic units specified in the Geology Dialog is defined 
as having an arithmetic mean of saturated thickness and logarithmic mean of 
transmissivity, then matrix storage should be specified such that "BUFF, RHS occupy 
different storage space."

Keep Initial Heads defines whether the initial hydraulic heads are to be stored 
for use in calculating drawdowns. Two options are provided in the pop-up menu; 
"initial heads are not kept" and "initial heads are kept." If drawdown is to be 
calculated from the hydraulic head solution and printed to the listing file or to 
external files for the postprocessing visualization, then the initial heads must be 
kept.

Head Value for Inactive Cells is the hydraulic head assigned to no-flow cells 
(IBOUND=0) in the finite-difference grid at the start of the simulation. Additional 
information about the IBOUND array can be found in Harbaugh and McDonald 
(1996a).

Misc. Control Options specifies if flow between adjacent constant head cells is 
to be calculated or not.

In the lower half of the dialog box, controls for rewetting dry cells are 
entered. Harbaugh and McDonald (1996a, 1996b) provide additional information about 
the definition of these parameters.

Wetting Flag is the flag that specifies whether the wetting capability is 
inactive or active.

Head Assigned to Dry Cells is the head assigned to cells that have gone dry 
during the simulation.

Wetting Factor is the factor that is included in the equation for rewetting cells. 
The equation for rewetting cells is given in the pop-up menu labeled "Equation for 
Rewetting Cells.".

Check for Wetting Cells is the iteration interval for attempting to rewet cells.

Equation for Rewetting Cells is the equation to define the initial head at cells 
that become wet, where EOT is the bottom of the modeled layer, WETFCT is specified in 
the editable field given above (Wetting Factor) and WETDRY is defined from the 
geospatial information layer Wetting Threshold.

Stresses/Solvers Dialog

In the Stresses/Solvers tab dialog box (Figure 5), the fluid stresses that are 
applied in the MODFLOW-96 simulation are defined along with the choice of the solver 
that is used in solving the matrix of equations generated from the finite-difference 
discretization of the ground-water flow equations. This version (version 1) of the 
preprocessor for MODFLOW-96 has included the following fluid stress packages 
discussed in McDonald and Harbaugh (1988) and Harbaugh and McDonald (1996a);
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Recharge,
Rivers,
Wells
Drains
General Head Boundary.
Evapotranspiration.

In addition, the following solvers discussed in Harbaugh and McDonald 
(1996a), Hill (1990) and Harbaugh (1995) have been included in the preprocessor for 
MODFLOW-96;

SIP-Strongly Implicit Procedure 
SOR Slice-Successive Overrelaxation Method 
PCG~Preconditioned Conjugate-Gradient Method 
DE4~Direct-Solution Package with Alternating Diagonal Ordering

MODFLOW DataSels

Figure 5. Stresses/Solvers dialog in MODFLOW-96 preprocessor. 

Choosing Stress Packages

To include a particular stress package in the MODFLOW-96 simulation, the box 
adjacent to the named stress is clicked. Boxes with check marks indicate stresses that 
are to be included in the MODFLOW-96 simulation. The fluid stresses that are included 
in a MODFLOW-96 simulation will have geospatial information layers created in 
which to import or create information for the fluid stress under consideration. A 
discussion of importing or creating information for the stress packages is given in 
the following section.
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Also associated with each stress package is a pop-up dialog box with two 
options; "steady stress" or "time-variable stress". If the "steady stress" option is 
chosen, then the stress information is assumed to be constant throughout the entire 
simulation. If the "time-variable stress" option is chosen, then time-variable 
information associated with that stress package must be entered for each of the stress 
periods. A discussion of entering time-variable information for fluid stresses in 
MODFLOW-96 simulations is given in the following section.

For the recharge and evapotranspiration fluid stresses, an additional control 
parameter is provided for each to orient the applied stress in the vertical dimension. 
For the recharge stress, the three options are "recharge is to top model layer only," 
"vertical recharge specified," and "recharge applied to highest active cell." The first 
and third option do not require geospatial information, although a geospatial 
information layer defining the recharge elevation is provided in the event that this 
option is changed. The second option uses the spatial distribution of the recharge 
elevation specified in a geospatial information layer to define the location in the 
vertical dimension where recharge is applied.

For the evapotranspiration stress, two options are provided; these are "ET 
calculated at top of grid" and "vertical distribution of ET specified in ET surface." The 
first option applies evapotranspiration to the top model layer of the domain, while 
the second option uses the spatial distribution specified in the ET surface to identify 
the location of evapotranspiration in the vertical dimension. A geospatial layer 
defining the evapotranspiration surface and other parameters of evapotranspiration 
is created when the evapotranspiration stress is specified.

Choosing a Solver

At the bottom of the dialog box, radio buttons are given for the solvers that can 
be used in solving the matrix equations generated in MODFLOW-96. Only one solver 
can be used at a time. The solver to be used is accessed by clicking the radio button 
adjacent to its name. Clicking the radio button associated with a given solver also 
changes the name of the last tab dialog box to the name of the solver that is chosen. 
Parameters associated with the solver that is chosen are edited in the dialog box with 
the solver name. In Figure 5, the PCG solver is chosen and PCG appears as the title of 
the last tab dialog box.

Time Dialog

The Time tab dialog box (Figure 6) contains information related to the temporal 
controls in MODFLOW-96 simulations. At the top of the dialog box, general temporal 
controls for the simulation are specified.

Transient/Steady State Flow is the flag used to specify whether a simulation is 
for steady-state or transient flow conditions. A pop-up menu is provided to specify 
this option.

Time Units is the flag to identify the time units used in the simulation. A pop­ 
up menu provides options for undefined time units, seconds, minutes, hours, days and 
years.

Number of Stress Periods displays the number of stress periods in the 
simulation; this is not an editable field. The number of stress periods can be changed 
only by adding or deleting stress periods in the table at the bottom of the dialog box.
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Figure 6. Time dialog in MODFLOW-96 preprocessor.

Editing Attributes of Stress Periods

To edit attributes associated with a given stress period, the cursor is moved to 
the table listing the stress periods in the middle of the dialog box; clicking one of the 
rows of the table places the current attributes of the stress period in the editable 
fields at the bottom of the dialog. Modifications to the attributes of the stress period 
are made in the editable fields at the bottom of the dialog box. Clicking the Modify 
button accepts the changes made in the editable fields and these changes are 
displayed in the table at the middle of the dialog box.

Deleting a Stress Period

To delete a stress period from the list, the cursor is moved to the table listing 
the stress periods. Clicking the row in the table highlights the information and then 
clicking the Delete button removes the stress period from the list, and the 
remaining stress periods are renumbered. It is important to note that deleting a 
stress period will remove the information associated with that stress period in the 
geospatial information layers. This information will be deleted once the OK button is 
clicked; clicking the Cancel button will cancel changes made in the dialog boxes. If 
the temporal information in the geospatial information layers may be needed at a 
later time, to avoid entering or importing that information again, it is recommended 
that the project information be saved to another filename by first exiting the dialog 
boxes and using the Save As... command in the File pull-down menu.
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Adding a Stress Period

To add a stress period, the cursor is moved to the table listing the stress period 
and a row of the table is highlighted by clicking on it. Clicking the Insert button 
adds a geologic unit below the highlighted stress period. Attributes associated with 
the stress period above are copied to the new stress period. The stress periods are 
then renumbered to reflect the addition of the new stress period.

Attributes of Stress Periods

Length is the length of the stress period in the time units specified in the 
upper part of this dialog box.

No. of steps is the number of time steps in the stress period.

Multiplier is the multiplier for the length of successive time steps in the stress 
period. Based on the length of the stress period and number of time steps in the stress 
period, the initial time step size is defined as

At1 = PERLEN 1 rp TSMULT"5  - 1

where PERLEN is the length of the stress period, NSTP is the number of time steps in 
the stress period, TSMULT is the multiplier for the stress period and Atx is the size of 
the first time step.

Time-Varying and Steady Stresses

Each of the fluid stress packages in the Stresses/Solvers dialog can have time- 
varying stresses specified, where the stress is constant within a stress period, but 
changes from one stress period to the next. In the geospatial information layers 
associated with a given fluid stress, a dialog will appear where the time-varying 
stress is entered for each of the stress periods. In the following section, a discussion 
of entering the time-varying stresses will be discussed for each of the fluid stresses 
considered in MODFLOW-96.

In the Stresses/Solvers dialog, a "steady stress" can also be specified for a fluid 
stress. In this case, the fluid stress specified in the first stress period will be used for 
all stress periods in the simulation. In the geospatial information layers associated 
with fluid stresses that are defined to be a "steady" stresses, the dialog where the 
time-varying stresses are entered will show all the stress periods, however, only 
information in the first stress period will be considered in the simulation. The other 
stress periods are listed in the event that the user may wish to change the fluid stress 
from "steady" to "time varying."

Output Files Dialog

In the Output Files tab dialog (Figure 7), the root name for the data and output 
files associated with the MODFLOW-96 simulation is specified along with the types of 
external files (other than the listing file) that are to be generated when MODFLOW-96 
is executed.
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Figure 7. Output Files dialog in MODFLOW-96 preprocessor. 

Root Name of Data and Output Files

The "root name" for all files associated with the simulation is specified in the 
editable field at the top of the dialog box. The same "root name" is given to all data 
files for the MODFLOW-96 simulation and all files with simulation results that are 
created. The extension associated with a given file will specify the type of 
information in that file. The types of file extensions will be discussed in the section 
"Creating Data Files and Executing MODFLOW-96."

Head/Drawdown Solutions

Hydraulic head and drawdown solutions from a MODFLOW-96 simulation can be 
exported to formatted text files or binary data files. For the hydraulic head and 
drawdown solutions, a pop-up menu is used to choose either of these file types, or 
"none" to indicate that an external file with hydraulic head or drawdown results will 
not be generated when executing MODFLOW-96. If the drawdown solution is to be 
stored to an external file, then the flag for keeping the initial hydraulic heads 
specified in the Misc. Controls dialog must be set to "keep the initial hydraulic 
heads."

If the postprocessing PIE for MODFLOW-96 discussed in this report is to be used, 
then the hydraulic head and/or drawdown solutions from the MODFLOW-96 
simulations must be stored in formatted text files.
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Cell-by-Cell Flows

Cell-by-cell flows derived from the volumetric budgets prepared by MODFLOW- 
96 are always stored in binary files. Cell-by-cell flows can be stored in a single 
binary file, or a separate binary file can be generated for each type of fluid stress, as 
well as the cell-by cell flows from the Block-Centered Flow (BCF) package. Boxes 
checked at the bottom of the Output Files dialog indicate that an option is active. For 
example, if the cell-by-cell flows are to be gathered into one file, the cursor is used to 
check the box in front of "gather all cell-by-cell binary output into one file." 
Specifying the export of the cell-by-cell flows for each of the stress packages and the 
BCF package is done separately by checking the appropriate boxes at the bottom of 
the dialog.

A new feature in MODFLOW-96 offers a more compact means of storing binary 
files having the cell-by-cell flow information. If this option box is checked, binary 
files will be stored in a compact format that requires less disk space; however, 
programs that read binary files generated from previous version of MODFLOW will 
have to be modified to read the compact format. If this option box is not checked then 
the method of storing binary files used in previous versions of MODFLOW is used.

Output Controls Dialog

In the Output Controls tab dialog (Figure 8), the frequencies of printing 
hydraulic head and drawdown solutions are specified along with the frequencies of 
printing the overall volumetric budget and the cell-by-cell flows.

MODFLOW DataSets

Last timestep of each Stress Period

Figure 8. Output Controls dialog in MODFLOW-96 preprocessor.
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Output in MODFLOW-96 Listing File

In the top of the dialog, the frequencies for including the hydraulic head and 
drawdown solution and the overall volumetric budget in the MODFLOW-96 listing file 
are specified. The frequencies of printing these results in the listing is given in the 
three options in the pop-up menu; these options are "none," "each Nth time step" 
and "last time step of each stress period." When the second option is used, the value of 
N is specified in the editable field at the right of the dialog. If a drawdown solution is 
to be printed in the MODFLOW-96 listing file,- then the flag for keeping the initial 
hydraulic heads specified in the Misc. Controls dialog must be set to "keep the initial 
hydraulic heads."

Output to External Files

If the hydraulic head solution, the drawdown solution or cell-by-cell flows are 
to be exported to external files, the frequencies of exporting this information to 
external files are specified in the editable fields at the bottom of the dialog. The 
editable fields for specifying the frequency of output to external files will be 
operational only if these files are specified in the Output Files dialog. The frequency 
of printing results in external files is given in the three options in the pop-up menu; 
these options are "none," "each Nth time step" and "last time step of each stress 
period." When the second option is used, the value of N is specified in the editable 
field at the right of the dialog. If a drawdown solution is to be exported to an external 
file, then the flag for keeping the initial hydraulic heads specified in the Misc. 
Controls dialog must be set to "keep the initial hydraulic heads."

Solver Dialog

Choosing a solver in the Stresses/Solvers dialog specifies the name of the 
solver in the title of the final tab dialog box of the MODFLOW-96 Preprocessor. Only 
one solver can be used in the simulation. The parameters associated with the 
operation of that solver are specified in editable fields and pop-up menus in the 
solver dialog.

SIP~Strongly Implicit Procedure Package

The parameters listed below are defined in the dialog when using the SIP 
solver (Figure 9). Additional information about the SIP package can be obtained from 
McDonald and Harbaugh (1988) and Harbaugh and McDonald (1996a).

MXITER is the maximum number of iterations allowed in a time step. 

NPARM is the number of iteration parameters. 

ACCL is the acceleration parameter.

HCLOSE is the maximum absolute change in the hydraulic head from one 
iteration to the next used in accepting the hydraulic head solution. The change in the 
hydraulic head solution from all modeled cells must be less than or equal to HCLOSE.

IPCALC is the flag indicating whether the seed for calculating iteration 
parameters will be specified or calculated internally.
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WSEED is the seed for calculating iteration parameters. This parameter is 
ignored if IPCALC is set to generate the seed internally to the program.

IPRSIP is the printing interval for information about the solution. The 
maximum head change is printed for each iteration of a time step whenever the time 
step is an even multiple of IPRSIP. The printout also is generated at the end of each 
stress period.

Figure 9. SIP Package dialog in MODFLOW-96 preprocessor

SOR Slice-Successive Overrelaxation Package

The parameters listed below are defined in the dialog when using the SOR 
solver (Figure 10). Additional information about the SOR package can be obtained 
from McDonald and Harbaugh (1988) and Harbaugh and McDonald (1996a).

MXITER is the maximum number of iterations allowed in a time step. 

ACCL is the acceleration parameter.

HCLOSE is the maximum absolute change in the hydraulic head from one 
iteration to the next used in accepting the hydraulic head solution. The change in the 
hydraulic head solution from all modeled cells must be less than or equal to HCLOSE.

IPRSOR is the printing interval for information about the solution. The 
maximum head change is printed for each iteration of a time step whenever the time
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step is an even multiple of IPRSOR. The printout also is generated at the end of each 
stress period.

MODFLOW DataSets
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Figure 10. SOR Package dialog in MODFLOW-96 preprocessor.

PCG-Preconditioned Conjugate-Gradient Package

The parameters listed below are defined in the dialog when using the PCG 
solver (Figure 11). Additional information about the PCG package can be obtained 
from Hill (1990).

MXITER is the maximum number of outer iterations. 

ITER1 is the maximum number of inner iterations.

NPCOND is the flag to select the matrix preconditioning. NPCOND=1 indicates the 
use of the modified incomplete Cholesky method. NPCOND=2 indicates the use of the 
polynomial method.

HCLOSE is the maximum absolute change in the hydraulic head from one 
iteration to the next used in accepting the hydraulic head solution. The change in the 
hydraulic head solution from all modeled cells must be less than or equal to HCLOSE.

RCLOSE is the maximum absolute residual used to accept the hydraulic head 
solution.

RELAX is the relaxation parameter.
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NBPOL is used only when NPCOND=2 and indicates the upper bound of the 
maximum eigenvalue. NPBOL=2 specifies the maximum eigenvalue to be 2. The other 
option forces the eigenvalue to be calculated.

IPRPCG is the printing interval for the solver. Information is printed for each 
iteration of a time step whenever the time step is an even multiple of IPRPCG. The 
printout also is generated at the end of each stress period.

MUTPCG is the flag controlling the information that is to be printed.

IPCGCD is the flag used when NPCOND=1 to control whether the same Cholesky 
decomposition is to used repeatedly.

Midified incomplete Cholesky (1)

Figure 11. PCG Package dialog in MODFLOW-96 preprocessor.

DE4~Direct-Solution Package with Alternating Diagonal Ordering

The parameters listed below are defined in the dialog when using the DE4 
solver (Figure 12). Additional information about the DE4 package can be obtained 
from Harbaugh (1995).

ITMX is the maximum number of iterations allowed in a time step.

MXUP is the maximum number of equations in the upper part of the equations 
to be solved. If set to 0, the program will calculate MXUP. Harbaugh (1995) provides 
information on defining this parameter.
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Figure 12. DE4 Package dialog in MODFLOW-96 preprocessor.

MXLOW is the maximum number of equations in the lower part of the equations 
to be solved. If set to 0, the program will calculate MXLOW. Harbaugh (1995) provides 
information on defining this parameter.

MXBW is the maximum bandwidth plus 1 of the [AL] matrix. If set to 0, the 
program will calculate MXBW.

IFREQis the flag indicating the frequency at which coefficients in the [A] 
matrix change. The pop-up menu provides the three options; IFREQ_=1 indicates 
constant linear flow equations with constant coefficients throughout the simulation; 
IFREQ.=2 indicates linear flow equations, but coefficients associated with hydraulic 
head in fluid stresses change at the beginning of a stress period; IFREQ,=3 indicates 
nonlinear flow equations.

MUTD4 is the flag indicating the information that is to be printed when 
convergence information is printed for a given time step. The pop-up menu provides 
the three options; MUTD4=0 indicates printing the number of iterations and the 
maximum head change; MUTD4=1 indicates printing of only the number of iterations; 
MUTD4=2 indicates no information is printed.

ACCL is the multiplier for the computed head change for each iteration.

HCLOSE is the maximum absolute change in the hydraulic head from one 
iteration to the next used in accepting the hydraulic head solution. The change in the 
hydraulic head solution from all modeled cells must be less than or equal to HCLOSE.
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IPRD4 is the printing interval for information about the solution. The 
maximum head change is printed for each iteration of a time step whenever the time 
step is an even multiple of IPRSIP. The printout also is generated at the end of each 
stress period.

GEOSPATIAL INFORMATION LAYERS

ArgusNE offers a CIS environment where two-dimensional coverages or layers 
are superimposed over each other. Note that the term "layer" in the context of 
ArgusNE does not have the same meaning as a modeled layer in a MODFLOW-96 finite- 
difference grid. Each layer in ArgusNE can be accessed and information can be 
generated using drawing tools that are part of ArgusNE, or spatial information can be 
imported from a variety of sources including text files, DXF files and ARC/Info Shape 
files. Additional information about importing geospatial information into ArgusNE 
layers can be found in ArgusNE User's Guide and the World-Wide Web site for Argus 
Interware (http://www.argusint.com).

In this section, the geospatial information layers generated as part of the 
MODFLOW-96 preprocessor are described; these include topographic, hydrologic, fluid 
stress and finite-difference geospatial information layers. Before executing 
MODFLOW-96, appropriate information must be entered into the geospatial 
information layers to describe the physical and hydrologic setting for the ground- 
water flow simulation and the numerical discretization of the modeled domain. To 
initiate this discussion on geospatial information layers, a brief summary of the 
types of geospatial information layers provided in the ArgusNE application is given.

Geospatial Information Layers in ArgusNE

ArgusNE supports several types of two-dimensional coverages or layers; these 
layer types are referred to as quadrilateral mesh, triangular mesh, finite-difference 
grid, map, domain, data and information layers. MODFLOW-96 is based on the finite- 
difference method, thus, the quadrilateral and triangular mesh layers which are 
used for finite-element numerical models are not used here.

Map layers provide a visual base for other geospatial information layers; 
information in map layers cannot be linked to other layers for use in the simulation. 
Map layers also can be used to visualize point data from ArgusNE Data layers using a 
variety of visualization tools provided in ArgusNE. The postprocessing visualization 
of hydraulic heads and drawdown for MODFLOW-96 simulations is generated in a map 
layer.

A domain layer specifies the areal extent of the modeled domain. The domain 
layer is used by the finite-difference grid layer to create the finite-difference grid 
for the numerical simulation.

Data layers allow scattered, girdded or meshed (point-wise) data to be imported 
which can then be linked to the finite-difference grid or visualized in map layers.

Information layers allow one to describe the distribution of geospatial 
information in the form of open contours, closed contours and point contours 
(similar to topographic map contours). This contour information is interpreted to 
define the spatial variability of the information in the layer. Various interpolation 
methods are available within ArgusNE for this purpose. This information can then be
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linked to the discretization in the finite-difference grid layer and can be eventually 
exported in a format that can be read by MODFLOW-96. Geospatial information created 
or imported in information layers does not need a prior knowledge of the finite- 
difference grid. The finite-difference grid is superimposed on information layers 
and the information within grid cells is extracted. Thus, it is easy to change 
discretization without affecting the underlying geospatial information.

A finite-difference grid layer allows a finite-difference grid to be generated 
based on the domain layer. The finite-difference grid layer can take advantage of a 
special type of information layer, referred to as a density layer, to automatically 
increase or decrease the density of finite-difference grid lines in selected regions of 
the modeled domain; grid lines also can be edited manually.

Additional information about the attributes of these types of layers and 
linking information between layers, as well as the methods of importing and 
exporting information to these layers is available in the ArgusNE User's Guide.

Creating Geospatial Information Layers in the MODFLOW-96 Preprocessor

The MODFLOW-96 Preprocessor dialog boxes are used to specify the simulation 
control parameters and create the geospatial information layers needed for the 
simulation of ground-water flow using MODFLOW-96. After preparing all information 
in the MODFLOW-96 Preprocessor dialog boxes and clicking the OK button, control is 
returned to the ArgusNE work space. Clicking the button adjacent to the Argus logo 
above the work space opens the floating window of geospatial information layers 
created by the MODFLOW-96 preprocessor (Figure 13). The checked layer is the active 
layer and an "eye" indicates whether a layer is visible or not.

Geospatial information layers are created for each geologic unit that is 
specified in the Geology tab dialog box within the MODFLOW-96 Preprocessor. In 
addition, geospatial information layers are created within each geologic unit for 
each of the fluid stresses that are specified; the exceptions are for the recharge and 
evapotranspiration stresses which have one geospatial information layer each. If 
additional geologic units or fluid stresses need to be specified, the project 
information can be edited at any time using the Edit Project Info command in the 
Edit menu. If new geologic units are added or removed, the geospatial information 
layers are renumbered to reflect the new order associated with the geologic units. 
Caution should be used in deleting geologic units in the Geology dialog as this will 
result in the loss of all geospatial information prepared for the geologic unit under 
consideration. If this information is to be used at a later time, it is recommended that 
the project information be saved to another filename by first exiting the dialog boxes 
and using the Save As... command in the File pull-down menu.

In the following, the geospatial information layers created by the MODFLOW- 
96 preprocessor are described. Reference to geospatial information layers for 
geologic units is denoted by [i], where the "i" denotes the sequence number of the 
geologic unit. Furthermore, geospatial information layers denoted by [i] indicate that 
a geospatial information layer of that type will be created for each geologic unit 
specified in the Geology dialog in the MODFLOW-96 Preprocessor.
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Figure 13. ArgusNE work space and floating layers window.

Drawing Size, Scale and Units

Prior to creating or importing information in geospatial information layers, it 
is recommended that the user specify the drawing size of the work space, as well as 
the scale and units of the modeling project. This information can be entered from the 
Drawing Size... and Scale and Units... commands in the Special pull-down 
menu. The Argus User's Guide provides information on setting attributes in the 
dialog boxes that appear when these commands are used.

General Model Information Layers

Map Unit[i]

For each geologic unit, a map layer is created by the MODFLOW-96 
preprocessor. Map information can either be imported from text, DXF or ARC/Info 
Shape files, or generated using the drawing tools on the tool palette (to the left of the 
work space). Details regarding importing map information can be found in the 
ArgusNE User's Guide and the ArgusNE Web site; information on the operation of the 
drawing tools can be found in the ArgusNE User's Guide.

24



Map information is only used as a visual basis for other geospatial information 
layers. Objects in map layers (lines, points and other vector objects) can be copied 
from the map layer and pasted into other geospatial information layers where 
attributes associated with the geospatial information layer can be assigned to these 
objects. For example, if the boundary line on a map is associated with a prescribed 
hydraulic head, the boundary line can be copied from the map layer to the 
Prescribed Head Unit[i] layer. Information about copying and pasting objects in 
ArgusNE can be found in the ArgusNE User's Guide.

MODFLOW Domain Outline

The MODFLOW Domain Outline layer contains the closed boundary that 
represents the maximum areal extent of the simulated regions from all geologic units 
in the vertical sequence. Because a three-dimensional simulation is visualized on a 
two-dimensional areal surface, the domain outline specified in this layer must be the 
union of the simulated regions in all of the geologic units. To account for the fact 
that each geologic unit may have a different simulated domain, a geospatial 
information layer for each geologic unit, referred to as Added Inactive Area 
Unit[i], is created. Areas that are outside the simulated region in a given geologic 
unit but lie within the model domain boundary specified in MODFLOW Domain 
Outline can be defined as being inactive in the layer Added Inactive Area 
Unit[i].

The domain outline can either be generated with the domain drawing tool 
shown at the left of the workspace in this layer or it can be imported from text, DXF 
or ARC/Info Shape files. Information on the operation of the domain drawing tools 
can be found in the ArgusNE User's Guide. If the domain outline is generated with the 
drawing tool, a dialog box will appear once a closed domain has been specified. In the 
dialog box, the density of finite-difference grid lines is specified as the average 
distance between grid lines in the units of the project.

Complex domain boundary shapes can be generated using the drawing tools. 
For example, islands of inactive areas can be placed within a simulated domain 
outline. Information on generating complex domain boundaries can be found in the 
ArgusNE User's Guide.

Added Inactive Area Unit[i]

To account for the fact that each geologic unit may have a different simulated 
region in comparison to the closed boundary represented in the MODFLOW Domain 
Outline layer, regions in the Added Inactive Area Unit[i] layer can be specified 
as being outside the modeled region in the geologic unit under consideration. If no 
information is entered into this layer, it is assumed that the domain outline in the 
MODFLOW Domain Outline layer is identical to the simulated region in the 
geologic unit under consideration. Furthermore, the information in the layer Added 
Inactive Area Unit[i] is only evaluated if the geologic unit is a simulated geologic 
unit (see the attributes of geologic units in the Geology dialog of the MODFLOW-96 
Preprocessor).

To specify an inactive area of a simulated geologic unit, select the "closed 
contour" tool from the tool palette and digitize a closed region. A discussion of the use 
of the contouring tools is provided in the ArgusNE User's Guide. Upon closing the 
region a dialog box appears and a value of 0 (zero) must be entered into the dialog 
under the "Value" column. The value of zero indicates that the closed region will be
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made inactive in the geologic unit under consideration. The shape of this inactive 
area can be changed or the inactive area can be move; information on performing 
these tasks is provided in the ArgusNE User's Guide.

Topographic Information Layers

The preprocessor for MODFLOW-96 assumes that all data is referenced to the 
same reference elevation or datum. For example, information in the fluid stress 
packages that refer to elevations such as river stages, elevations of drains, and so 
forth, must make use of the same reference elevation as the topographic information 
layers. Furthermore, all geologic units must have topographic information specified, 
including nonsimulated geologic units (that is, those geologic units assumed to be 
semi-confining units with quasi-steady vertical leakage).

The default elevations specified by the MODFLOW-96 preprocessor for the 
layers Elevation Top Unit[i] and Elevation Bottom Unit[i] are set to a constant 
value of zero throughout the modeled region. The user must change these elevations 
to reflect the topographic information in the model simulation, otherwise errors will 
arise in executing MODFLOW-96. Methods of changing the default elevation and 
creating spatially variable topographic information are discussed below.

Elevation Top Unit[i]

Elevation Top Unit[i] specifies the top elevation of the geologic unit. The 
elevation of the top of the geologic unit can be a constant or spatially varying in the 
areal dimensions. Spatially varying elevation can be created using the contouring 
tools from the tool palette, copying vector objects from other layers such as map 
layers and information layers, or by importing information contours from text, DXF 
or ARC/Info Shape files. If the contouring tools are used, all three contouring tools 
(closed, line or point) can be used to create a spatially varying elevation. After a 
(closed, line or point) contour is applied to the work space, a dialog will appear where 
the value associated with the elevation contour can be entered.

To specify a constant elevation, or default elevation, or change the method of 
interpolating elevation, or program a spatially varying elevation for the top of the 
geologic unit, the Layers dialog must be used. Moving the cursor to the "Layers..." 
button in the floating layers window and clicking(Figure 13), opens the Layers 
dialog (Figure 14). The list at the top of the dialog is the list of layers. Highlighting 
the layer under consideration, in this case Elevation Top Unit[i], in that list by 
clicking it with the cursor shows the parameters associated with that information 
layer in the table at the bottom of the dialog box. Moving the cursor to the "Value" 
column and clicking and holding causes the "expression" box to appear. Moving the 
cursor over the "expression" box causes the Expression dialog to appear (Figure 
15). A mathematical expression, for example, a numerical value can be entered or 
another geospatial information layer can be used as the expression for the top of the 
geologic unit. Clicking OK exits the expression dialog. Clicking Cancel exits the 
expression dialog without modifying the value. The interpolation method for the 
layer can be changed by using the pop-up menu at the bottom of the layers dialog. 
More detailed information on using the Layers dialog and Expression dialog can 
be found in the ArgusNE User's Guide.
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Layers
Name Units Type
MODFLOW Domain Outline Density <S> Domain
MODFLOW Grid Density <?> Information
MODFLOW FD Grid <D Grid
Map Unitl <3> Maps
Elevation Top Unit"! L {-.i} Information
Elevation Bottom Unitl L <D Information
Added Inactive Area Unitl <D Information
Prescribed Head Unitl L <D Information
Initial Head Unitl L <D Information

Layer:

Layer Parameters:
Name Units Type Value
Elevation Top Unit! L

When probed for value, use: interpolation method

Parameter:

Figure 14. ArgusNE Layers dialog.

Expression

Elevation Bottom Unitl

MODFLOW FD Grid
Elevation Top Unitl
Elevation Bottom Unit
Added Inactive Area I 
Prescribed Head Unit 
Initial Head Unitl 
Hydraulic Cond Unitl 
Specific Yield Unitl 
Specific Storage Unit'

it-

15. ArgusNE Expression dialog.

If the spatial distribution of elevation is available by a set of scattered or 
gridded data points, this information can be imported. To do so, open the Layers 
dialog and select the layer to be changed from an ArgusNE Information layer to an 
ArgusNE Data layer. Moving the cursor to the Type field of the layer and clicking and
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holding displays the pop-up menu. Selecting "Data" from the pop-up menu will 
convert the layer to an ArgusNE Data layer that will accept scattered or gridded data 
points.

Elevation Bottom Unit[i]

The elevation for the bottom of a geologic unit can be specified in a manner 
similar to that discussed for the layer Elevation Top Unit[i].

Consistent Elevations Between Geologic Units

In the MODFLOW-96 preprocessor, it is assumed that there will be no "gaps" or 
inconsistencies in the elevations between geologic units, for example, the bottom of 
geologic unit 1 must equal the top of geologic unit 2. To insure that this occurs, the 
user should specify the top elevation of geologic unit 1 and the bottom of all geologic 
units (1, 2, ...N) using the methods discussed for layer Elevation Top Unit[i]. The 
top elevation of geologic units 2, 3, ...N given in layers Elevation Top Unit[i], 
i=2,3,...N can then be specified as being equal to the bottom elevation of the 
preceding geologic unit in the sequence. To specify this equivalence, the Layers 
dialog must be used. Clicking the "Layers..." button at the top of the floating layers 
window opens the Layers Dialog. Highlighting the layer under consideration, in this 
case Elevation Top Unit[i], i=2,3,...N, by clicking it with the cursor shows the 
parameters associated with that information layer in the list at the bottom of the 
dialog box. Moving the cursor to the "Value" column and clicking and holding causes 
the "expression" box to appear. Releasing the cursor over the "expression" box 
causes the Expression dialog to appear. From the list of layers at the bottom of the 
dialog, the layer Elevation Bottom Unit[i-l] is chosen by clicking it. Double 
clicking the parameter name (in this case Elevation Bottom Unit[i-l]) in the list 
to the right, places this parameter in the expression at the top of the dialog box. 
Clicking OK applies the change and exits the expression dialog.

If geologic units are deleted or added, the topographic information should be 
edited to insure consistent elevations between geologic units.

Elevation of Top and Bottom of Model Layers

Specifying the elevation of the top and bottom of the geologic unit also 
specifies the elevation of the top and bottom of each model layer in a geologic unit. 
The number of model layers in a geologic unit is specified in the Geology dialog box 
in the MODFLOW-96 Preprocessor. Although the thickness of the geologic unit can 
vary in the areal dimensions, the thickness of the geologic unit is divided into model 
layers of equal thickness at a given areal location.

Hydrogeologic Information Layers 

Prescribed Head Unit[i]

The point contour, line contour and closed contour tools in the tool palette can 
be used to specify points, lines, and areas of prescribed head in the geologic unit. 
Objects copied from other geospatial information layers, such as map layers, also can 
be used to specify locations of prescribed head in the modeled geologic units. Also, 
locations of prescribed head can be imported from text, DXF and ARC/Info Shape files. 
Information concerning the use of the contour tools and copying information from 
one layer to another and importing information from files is provided in the
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ArgusNE User's Guide. If the prescribed head distribution is available through a set of 
data points, change the layer type to an ArgusNE Data layer and import that 
information (see the procedure above in Topographic Information Layers).

After placing a contour of prescribed head (point, line or area) in the modeled 
domain a dialog box appears where the value of the prescribed head is specified 
under the value column in the dialog. If an object was copied from another geospatial 
information layer or imported, double clicking on the object will bring up the dialog 
where the value of the prescribed head can be specified.

The prescribed hydraulic head specified in line contours and closed contours 
are assumed to be constant over the line or area. To define a spatially varying 
prescribed hydraulic head along a line or area, segments of lines or areas can be 
placed end to end, where in each segment the prescribed head is constant. To 
accommodate this, the Allow Intersection command in the Special menu should 
be used. If the Allow Intersection command is active, a check mark will appear 
next to it in the pull-down menu. The Allow Intersection command allows 
contours to intersect each other, such as placing segments of lines or areas adjacent 
to each other.

The application of the prescribed head assumes that it is applied over the 
entire thickness of the geologic unit. Therefore, if the geologic unit is divided into 
more than one model layer, the specified hydraulic head will be applied to each 
model layer in the vertical dimension at the areal locations specified.

Initial Head Unit[i]

The initial hydraulic head can be specified to be a constant or contour 
information describing a spatially varying initial hydraulic head can be imported or 
generated. The default initial hydraulic head is zero for all geologic units. To change 
the default value or to change the interpolation method or program a spatially 
variable initial hydraulic head the user must enter the Layers dialog and the 
Expression dialog for the layer Initial Head Unit[i]. A brief discussion of this 
procedure is presented in the section describing the layer Elevation Top Unit[i]. 
The ArgusNE User's Guide provides more detailed information about the use of the 
Layers dialog and the Expression dialog.

The initial hydraulic head also can be imported from text, DXF or ARC/Info 
Shape files, or generated using the point, line and closed contour tools to the left of 
the project work space. If the contour tools are used to generate a spatial distribution 
of initial hydraulic head, a dialog will appear after applying a given contour tool 
where the initial hydraulic head is specified in the dialog under the "value" column. 
If the contours of initial hydraulic head are imported, doubling clicking on a contour 
in the work space will show the dialog box in which the initial hydraulic head can be 
entered or edited. If the initial hydraulic head distribution is available through a set 
of data points, change the layer type to an ArgusNE Data layer and import the 
information (see detailed procedure above in Topographic Information Layers)

The initial hydraulic head in the geologic unit is assumed to be applied over 
the entire thickness of the geologic unit. Therefore, if the geologic unit is divided 
into more than one model layer, the hydraulic head at a given areal location will be 
applied to each model layer in the vertical dimension.
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Hydraulic Conductivity [i]

The spatial variability of the hydraulic conductivity of the geologic unit can 
be specified similarly to that discussed for the layer Initial Head Unit[i]. However, 
the hydraulic conductivity requires the definition of two parameters, the hydraulic 
conductivity in the x-direction (Kx) and the hydraulic conductivity in the z-direction 
(Kz ); the hydraulic conductivity in the y-direction is known from the hydraulic 
conductivity in the x-direction and the anisotropic ratio defined for each geologic 
unit in the Geology dialog box in the MODFLOW-96 Preprocessor. If the hydraulic 
conductivity distribution is available through a set of data points, change the layer 
type to an Argus NE Data layer and import that information (see detailed procedure 
above in Topographic Information Layers)

If the geologic unit is assumed to be nonsimulated and it lies between simulated 
geologic units, then the hydraulic conductivity in the z-direction must be specified 
because the nonsimulated geologic unit is assumed to be a semi-confining unit with 
quasi-steady vertical leakage.

The hydraulic conductivity (both Kx and KZ) is assumed to be uniform over the 
entire thickness of the geologic unit. Therefore, if the geologic unit is divided into 
more than one model layer, the hydraulic conductivity at a given areal location will 
be applied to each model layer in the vertical dimension; however, the hydraulic 
conductivity (both Kx and Kz ) can vary spatially in the areal dimensions.

Specific Yield Unit[i]

The spatial variability of the specific yield of the geologic unit can be 
specified similarly to that discussed for the layer Initial Head Unit[i]. Although in 
particular model simulations, the specific yield may not be used, for example, in a 
confined aquifer, this information layer is still provided for the geologic unit in the 
event that the geologic unit is converted from a confined aquifer to an unconfined 
aquifer. If the specific yield distribution is available through a set of data points, 
change the layer type to an ArgusNE Data layer and import that information (see 
detailed procedure above in Topographic Information Layers)

Similarly to the hydraulic conductivity, the specific yield is assumed to be 
uniform over the entire thickness of the geologic unit. Therefore, if the geologic 
unit is divided into more than one model layer, the specific yield at a given areal 
location will be applied to each model layer in the vertical dimension; however, the 
specific yield can vary spatially in the areal dimensions.

Specific Storage Unit[i]

The spatial variability of the specific storage of the geologic unit can be 
specified similarly to that discussed for the layer Initial Head Unit[i]. Although in 
a particular simulation, the specific storage may not be used, for example, in a 
steady-state flow simulation, this information layer is still provided for the geologic 
unit in the event that the type of simulation changes to where it will be needed in 
the simulation. If the specific storage distribution is available through a set of data 
points, change the layer type to an ArgusNE Data layer and import that information 
(see detailed procedure above in Topographic Information Layers)
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Similarly to the hydraulic conductivity, the specific storage is assumed to be 
uniform over the entire thickness of the geologic unit. Therefore, if the geologic 
unit is divided into more than one model layer, the specific storage at a given areal 
location will be applied to each model layer in the vertical dimension; however, the 
specific storage can vary spatially in the areal dimensions.

Wetting Threshold Unit[i]

The spatial variability of the wetting threshold of the geologic unit can be 
specified similarly to that discussed for the layer Initial Head Unlt[i]. Although in 
particular model simulations, the wetting threshold may not be used, for example, in 
a confined aquifer, this information layer is still provided for the geologic unit in 
the event that the geologic unit is converted from a confined aquifer to a unconfined 
aquifer and rewetting calculations are specified in the Misc. Controls dialog. If the 
wetting threshold distribution is available through a set of data points, change the 
layer type to an ArgusNE Data layer and import that information (see detailed 
procedure above in Topographic Information Layers)

Similarly to the hydraulic conductivity, the layer Wetting Threshold 
Unitfi] has two parameters that must be defined, the wetting threshold and the 
wetting flag. The wetting threshold and wetting flag used in MODFLOW-96 simulations 
are described in McDonald and others (1992). The wetting flag is an integer (-1, 0, or 
1) that indicates which neighboring cells can cause a cell to rewet. If the wetting 
flag is -1, only the cell below the dry can cause a cell to rewet. If the wetting flag is 1, 
the cell below the dry cell and the four adjacent cells can cause a cell to rewet. If the 
wetting flag is 0, the cell can not be rewetted.

The wetting threshold will only be applied to unconfined geologic units or 
geologic units denoted as being convertible between confined and unconfined. If a 
geologic unit is unconfined, only the top model layer in the geologic unit is 
unconfined; the model layers below the top model layer are assumed to be 
convertible. Furthermore, the wetting threshold is assumed to be constant over the 
thickness of the geologic unit. Therefore, if the geologic unit is divided into more 
than one model layer, the wetting threshold at a given areal location will be applied 
to each model layer in the vertical dimension; however, the wetting threshold and 
wetting flag can vary spatially in the areal dimensions.

Recharge Information Layer 

Recharge

In MODFLOW-96, the recharge stress is applied as a two-dimensional spatial 
distribution of the recharge rate given in units of length per time, or equivalently, 
length cubed per time per unit area. The volumetric recharge applied to each model 
cell is automatically calculated based on the area of the cell. If finite-difference 
discretization changes, the volumetric recharge applied to each model cell will be 
automatically recalculated and it is not necessary to change the underlying recharge 
rate specified in the layer Recharge. The spatial variability of the parameters 
describing recharge can be specified similarly to that discussed for the layer Initial 
Head Unit[i].

The vertical distribution of recharge depends on the recharge option specified 
in the Stresses/Solvers dialog. If the recharge option is specified to apply recharge to 
the top model layer only or to apply recharge to the highest active cell, then the
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recharge elevation in the dialog that appears when entering or editing information 
in the layer Recharge is not used. However, the recharge elevation will continue to 
appear in the dialog associate with the layer Recharge in the event that the 
recharge option is changed in other simulations.

If the recharge option in the Stresses/Solvers dialog is specified to apply 
recharge based on the recharge elevation, then the spatial distribution of the 
recharge elevation prescribed in the layer Recharge is used to identify the geologic 
unit and the model layer where recharge is applied.

If more than one stress period is included in the simulation and the recharge 
stress has been specified to be time-varying in the Stresses/Solvers dialog, then the 
recharge rates should be entered into the spaces provided for each stress period in 
the dialog that appears when entering or editing information in the layer 
Recharge. If the recharge stress has been specified to be steady in the 
Stresses/Solvers dialog, then it is sufficient to specify only the recharge rate in the 
first stress period.

Evapotranspiration Information Layer 

Evapotranspiration

In MODFLOW-96, the evapotranspiration stress is applied as a two-dimensional 
spatial distribution of the evapotranspiration rate given in units of length per time, 
or equivalently, length cubed per time per unit area. The volumetric 
evapotranspiration rate applied to each model cell is automatically calculated based 
on the area of the cell. If finite-difference discretization changes, the 
evapotranspiration rate for each cell is automatically recalculated. The spatial 
variability of parameters associated with the evapotranspiration (evapotranspiration 
surface, evapotranspiration extinction depth and the evapotranspiration rate) can be 
specified similarly to that discussed for the layer Initial Head Unit[i].

The vertical distribution of the evapotranspiration rate depends on the 
evapotranspiration option specified in the Stresses/Solvers dialog. If the 
evapotranspiration option is specified to apply evapotranspiration to the top model 
layer only, then the evapotranspiration surface is not used to specify the vertical 
location for applying the evapotranspiration rate.

If the evapotranspiration option in the Stresses/Solvers dialog box in the 
MODFLOW-96 Preprocessor is specified to apply evapotranspiration based on the 
evapotranspiration surface, then the spatial distribution of the evapotranspiration 
surface elevation prescribed in the layer Evapotranspiration is used to identify 
the geologic unit and the model layer where evapotranspiration is applied.

If more than one stress period is included in the simulation and the 
evapotranspiration stress has been specified to be time-varying in the 
Stresses/Solvers dialog, then the evapotranspiration rates should be entered into the 
spaces provided for each stress period in the dialog that appears when entering or 
editing information in the layer Evapotranspiration. If the recharge stress has 
been specified to be steady in the Stresses/Solvers dialog, then it is sufficient to 
specify only the recharge rate in the first stress period.
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Well Information Layers 

Wells Unit[i]

Wells are specified in the Well Unit[i] layer by using the point contour tool 
from the tool palette, copying point objects from other layers such as map layers or 
importing information from text, DXF or ARC/Info Shape files. Clicking in the work 
space using the point contour tool places a well where the cursor is located. A dialog 
box appears where the well information is entered. The well is defined by the 
elevation of the top of the open interval in the geologic unit, the elevation of the 
bottom of the open interval in the geologic unit and the stress in units of cubic 
length per time (positive values indicating recharge and negative values indicating 
withdrawals from the geologic unit). Moving the cursor to a point object and double 
clicking on it will show the well information associated with that object.

If the geologic unit is divided into several model layers, the cells in the 
vertical dimension intersected by the open interval of the well will be specified in 
the preprocessor and the appropriate amount of the recharge or pumping rate will 
be automatically applied to each cell according to its length in the cell.

If more than one stress period is included in the simulation and the well stress 
has been specified to be time-varying in the Stresses/Solvers dialog, then the 
recharge or pumping rate should be entered into the space provided for each stress 
period. If the well stress has been specified to be steady in the Stresses/Solvers 
dialog, then it is sufficient to specify only the pumping or recharge in the first 
stress period.

River Information Layers

Rivers can be specified as being "line" rivers or "area" rivers. Similar 
information is requested with the exception of the conductance of the bottom of the 
river. The conductance per unit length of a "line" river is specified in units of 
length per time. The length of the "line" river within a model cell multiplied by the 
conductance per unit length will yield the total conductance of that river in the 
model cell. Similarly, for an "area" river, the conductance per unit area is specified 
in units of inverse time. The area of the "area" river in a cell multiplied by the 
conductance per unit area associated with the "area" river yields the total 
conductance of the river in the model cell. With these definitions of parameters for 
"line" and "area" rivers, it is not necessary for the user to have prior knowledge of 
the total conductance or the length of the "line" river or the area of an "area" river 
in a model cell; this information is calculated internally by the preprocessor. Thus, it 
is not necessary to change the conductance applied to a river if the discretization of 
the finite-difference grid is changed.

Line River Unit[i]

Line rivers are specified using the line contour tool to the left of the work 
space. After using the line contour tool to specify the location of a segment of a line 
river, a dialog appears where information associated with that segment of the river 
is entered. The information required for the line river is the conductance per unit 
length in units of length per time, the bottom elevation of the river and the stage of 
the river for each stress period. If the river stress was specified to be "steady" in the 
Stresses/Solvers dialog, then it is necessary to enter only the stage associated with 
the first stress period.
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The attributes defining the line river in the dialog are assumed to be constant 
over the length of the line contour specified in the work space. To incorporate 
varying properties over the length of the river, for example, conductance, bottom 
and stage, segments of line rivers must be placed end to end. To accommodate this, the 
Allow Intersection command in the Special pull-down menu should be used. If 
the Allow Intersection command is active, a check mark will appear next to it in 
the pull-down menu. The Allow Intersection command allows contours to intersect 
each other, such as placing segments of a line river end to end.

If there is more than one model layer in the geologic unit, the location of the 
line river in the vertical direction will depend on the elevation associated with the 
bottom of the line riverbed. The river will be located within the model layer that 
contains the bottom elevation of the riverbed.

Area River Unit[i]

Area rivers are specified using the closed contour tool to the left of the work 
space. After using the closed contour tool to specify the location of a segment of an 
area river, a dialog appears where information associated with that segment of the 
river is entered. The information required for the area river is the conductance per 
unit area in units of inverse time, the bottom elevation of the river and the stage of 
the river for each stress period. If the river stress was specified to be "steady" in the 
Stresses/Solvers dialog, then it is necessary to enter only the stage associated with 
the first stress period.

The attributes defining the area river in the dialog are assumed to be constant 
over the area of the closed contour specified in the work space. To incorporate 
varying properties over the length of the area river, for example, conductance, 
bottom and stage, segments of area rivers must be placed end to end. To accommodate 
this, the Allow Intersection command in the Special pull-down menu should be 
used. If the Allow Intersection command is active, a check mark will appear next 
to it in the pull-down menu. The Allow Intersection command allows contours to 
intersect each other, such as placing segments of an area river end to end.

If there is more than one model layer in the geologic unit, the location of the 
area river in the vertical direction will depend on the elevation associated with the 
bottom of the area riverbed. The river will be located within the model layer that 
contains the bottom elevation of the riverbed.

Drain Information Layers

Drains can be specified as being "line" drains or "area" drains. Similar 
information is requested with the exception of the conductance of drain. The 
conductance per unit length of a "line" drain is specified in units of length per time. 
The length of the "line" drain within a model cell multiplied by the conductance per 
unit length will yield the total conductance of that drain in the model cell. Similarly, 
for an "area" drain, the conductance per unit area is specified in units of inverse 
time. The area of the "area" drain in a cell multiplied by the conductance per unit 
area associated with the "area" drain yields the total conductance of the drain in the 
model cell. With these definitions of parameters for "line" and "area" drains, it is not 
necessary for the user to have prior knowledge of the total conductance or the 
length of the "line" drain or the area of an "area" drain in a model cell; this 
information is calculated internally by the preprocessor. Thus, it is not necessary to
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change the conductance applied to a drain if the discretization of the finite- 
difference grid is changed.

Line Drain Unit[i]

Line drains are specified using the line contour tool to the left of the work 
space. After using the line contour tool to specify the location of a segment of a line 
drain, a dialog appears where information associated with that segment of the drain 
is entered. The information required for the line drain is the conductance per unit 
length in units of length per time, the elevation of the drain, and whether the drain 
is operating or not during the stress period. If the drain is operating, a value of 
"True" is used, otherwise a value of "False" is used. If the drain stress was specified to 
be "steady" in the Stresses/Solvers dialog, then it is necessary to enter the operation 
of the drain in the first stress period only.

The attributes defining the line drain in the dialog are assumed to be constant 
over the length of the line contour specified in the work space. To incorporate 
varying properties over the length of the drain, for example, conductance, elevation 
and operation, segments of line drains must be placed end to end. To accommodate 
this, the Allow Intersection command in the Special pull-down menu should be 
used. If the Allow Intersection command is active, a check mark will appear next 
to it in the pull-down menu. The Allow Intersection command allows contours to 
intersect each other, such as placing segments of a line drain end to end.

If there is more than one model layer in the geologic unit, the location of the 
line drain in the vertical direction will depend on the elevation associated with the 
line drain. The drain will be located within the model layer that contains the 
elevation of the drain.

Area Drain Unit[i]

Area drains are specified using the closed contour tool to the left of the work 
space. After using the closed contour tool to specify the location of a segment of an 
area drain, a dialog appears where information associated with that segment of the 
drain is entered. The information required for the area drain is the conductance per 
unit area in units of inverse time, the elevation of the drain, and whether the drain 
is operating or not during the stress period. If the drain is operating, a value of 
"True" is used, otherwise a value of "False" is used. If the drain stress was specified to 
be "steady" in the Stresses/Solvers dialog, then it is necessary to enter the operation 
of the drain in the first stress period only.

The attributes defining the area drain in the dialog are assumed to be constant 
over the closed contour specified in the work space. To incorporate varying 
properties over the area of the drain, for example, conductance, elevation and 
operation, segments of area drains must be placed end to end. To accommodate this, 
the Allow Intersection command in the Special pull-down menu should be used. 
If the Allow Intersection command is active, a check mark will appear next to it in 
the pull-down menu. The Allow Intersection command allows contours to intersect 
each other, such as placing segments of an area drain end to end.

If there is more than one model layer in the geologic unit, the location of the 
area drain in the vertical direction will depend on the elevation associated with the 
area drain. The drain will be located within the model layer that contains the bottom 
elevation of the drain.
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General Head Boundary Information Layers

General head boundary stresses can be specified as being a "point," "line" or 
"area." Similar information is requested with the exception of the conductance of 
each. A "point" general head boundary stress requires conductance to be given in 
units of length squared per time. A "line" general head boundary stress requires 
conductance to be given in units of length per time. An "area" general head 
boundary requires conductance to be given in units of inverse time. With these 
definitions of parameters for "line" and "area" general head boundary stresses, it is 
not necessary for the user to have prior knowledge of the total conductance of the 
general head boundary in a model cell; this information is calculated internally in 
the preprocessor by using the length and area of the "line" and "area" general head 
boundary stress, respectively. Thus, it is not necessary to change the conductance 
applied to a general head boundary stress if the discretization of the finite- 
difference grid is changed. If a "point" general head boundary stress is applied, 
however, changing discretization will not change the conductance of the stress. 
Thus, the user should use caution in applying "point" general head boundary 
stresses when changing discretization in the finite-difference grid because the same 
conductance is applied regardless of the discretization.

Point Gen Head Boundary Unit[i]

Point general head boundary stresses are specified using the point contour 
tool from the tool palette. After using the point contour tool to specify the location of 
a general head boundary stress, a dialog appears where information associated with 
that stress is entered. The information required for the point general head boundary 
stress is the conductance in units of length squared per time, and boundary head for 
each stress period. If the general head boundary stress was specified to be "steady" in 
the Stresses/Solvers dialog, then it is necessary to enter the boundary head in the 
first stress period only.

The application of the point general head boundary stress in the geologic unit 
assumes that the stress is applied over the thickness of the geologic unit. Therefore, 
if the geologic unit is divided into more than one model layer, each cell in the 
vertical direction will be given attributes associated with the point general head 
boundary stress.

Line General Head Boundary Unit[i]

Line general head boundary stresses are specified using the line contour tool 
to the left of the work space. After using the line contour tool to specify the location 
of a general head boundary stress, a dialog appears where information associated 
with that stress is entered. The information required for the line general head 
boundary is the conductance per unit length in units of length per time, and 
boundary head for each stress period. If the general head boundary stress was 
specified to be "steady" in the Stresses/Solvers dialog, then it is necessary to enter 
the boundary head in the first stress period only.

The attributes defining the line general head boundary stress in the dialog are 
assumed to be constant over the line contour specified in the work space. To 
incorporate varying properties over the length of a general head boundary stress, 
for example, the conductance and boundary head, segments of area general head 
boundary stresses must be placed end to end. To accommodate this, the Allow
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Intersection command in the Special pull-down menu should be used. If the 
Allow Intersection command is active, a check mark will appear next to it in the 
pull-down menu. The Allow Intersection command allows contours to intersect 
each other, such as placing segments of an area general head boundary stress end to 
end.

The application of the line general head boundary stress in the geologic unit 
assumes that the stress is applied over the thickness of the geologic unit. Therefore, 
if the geologic unit is divided into more than one model layer, each cell in the 
vertical direction will be given attributes associated with the line general head 
boundary stress.

Area General Head Boundary Unit[i]

Area general head boundary stresses are specified using the closed contour 
tool to the left of the work space. After using the closed contour tool to specify the 
location of a general head boundary stress, a dialog appears where information 
associated with that stress is entered. The information required for the area general 
head boundary is the conductance per unit area in units of inverse time, and 
boundary head for each stress period. If the general head boundary stress was 
specified to be "steady" in the Stresses/Solvers dialog, then it is necessary to enter 
the boundary head in the first stress period only.

The attributes defining the area general head boundary stress in the dialog 
are assumed to be constant over the closed contour specified in the work space. To 
incorporate varying properties over the area of the general head boundary stress, 
for example, the conductance and boundary head, segments of area general head 
boundary stresses must be placed end to end. To accommodate this, the Allow 
Intersection command in the Special pull-down menu should be used. If the 
Allow Intersection command is active, a check mark will appear next to it in the 
pull-down menu. The Allow Intersection command allows contours to intersect 
each other, such as placing segments of an area general head boundary stress end to 
end.

The application of the area general head boundary stress in the geologic unit 
assumes that the stress is applied over the thickness of the geologic unit. Therefore, 
if the geologic unit is divided into more than one model layer, each cell in the 
vertical direction will be given attributes associated with the area general head 
boundary stress.

Finite-Difference Grid Information Layers

The information layers associated with the finite-difference discretization and 
the finite-difference grid are presented last in this section because, in general, a 
modeling project should proceed by acquiring or generating the topographic and 
hydrologic information first, and then evaluating this information in order to 
specify where increased discretization is warranted to capture the spatially varying 
attributes of the geospatial information. Because geospatial information is specified 
independently of the finite difference grid in ArgusNE, rediscretization does not 
require the user to respecify the underlying geospatial information.

37



MODFLOW Grid Density

The layer MODFLOW Grid Density is an ArgusNE information layer that is 
used by the MODFLOW FD Grid layer to define the discretization of the finite 
difference grid. Regions where increased or decreased discretization may be 
warranted can be prescribed in the MODFLOW Grid Density layer. The point, line 
and closed contour tools can be used to specify the approximate distance between 
finite-difference grid lines in regions of the modeled domain. After using one of the 
contour tools, a dialog will appear where the finite-difference grid density is 
entered; the density is the approximate distance between finite difference grid lines. 
Examples of using the density layer to specify the finite-difference discretization are 
described in the ArgusNE User's Guide.

If grid density is not specified, the density specified in the layer MODFLOW 
Domain Outline is used in creating the finite difference grid.

MODFLOW FD Grid

If the model domain outline has been specified in the layer MODFLOW 
Domain Outline, the finite-difference grid can be generated automatically using 
the magic wand tool from the tool palette. A discussion of the operation of the tools in 
the grid layer can be found in the ArgusNE User's Guide. These tools can be used to 
edit the horizontal and vertical grid lines.

The finite-difference grid is assumed to be extruded in the vertical dimension 
and applies to all geologic units. Thus, any changes made in finite-difference grid 
are extruded to all geologic units. Inactive cells outside the modeled domain are noted 
as thatched areas. However, each geologic unit can have additional inactive cells as 
specified in the layer Added Inactive Area Unit[i].

Grid Type, Grid Direction and other Grid Operations

In the Edit pull-down menu of the layer MODFLOW FD Grid, the commands 
Grid Type allows the user to modify the type of finite difference grid used in the 
simulation. In the preprocessor for MODFLOW-96, it is assumed that a Block- 
Centered finite-difference grid is used; this is the default setting and it should not 
be changed when using the preprocessor described in this report.

The command Grid Direction in the Edit pull-down menu allows the user to 
specify the direction in which grid information (that is, geospatial information 
linked to the grid) is exported. To be consistent with previous uses of MODFLOW, it is 
recommended that the grid direction be specified as Positive X and Negative Y; the 
user should make these changes using the Grid Direction menu item. Among other 
things, this will ensure that the listing of model parameters and results in files 
generated by MODFLOW-96 will appear in matrix form in the same orientation as the 
finite-difference grid on the screen; the top row of cells on the screen will 
correspond to the top row of model parameters and results for each model layer given 
in the files that are created. Here it is assumed that orientation of (positive) x-axis is 
to the right of the work space and the orientation of the (positive) y-axis is to the top 
of the work space.

The Toggle Active menu in the Edit menu can be used to make selected 
finite-difference grid cells inactive or active. For example, this command may be
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useful in making selected grid cells active or inactive along a complexly shaped 
domain boundary that may isolate grid cells from the remainder of the grid because 
of the density of the discretization that is applied. The use of the Toggle Active 
command and other grid operations are described in the ArgusNE User's Guide.

Adding Geospatial Information Layers

The list of geospatial information layers created in the MODFLOW-96 
preprocessor and discussed above are directly correlated to the information that is 
used in the numerical model. In many ground-water modeling projects, however, 
model information required for the simulation may not be available, while proxy 
information that may be used to infer hydrogeologic properties may be available. For 
example, instead of having information on hydraulic conductivity, the spatial 
distribution of soil types may be available. If hydraulic conductivity can be inferred 
from soil types, then the hydraulic conductivity could be linked to this information.

Geospatial information layers can be added to the layers already created by the 
MODFLOW-96 preprocessor. Using the example above, a geospatial information layer 
for soil types for each geologic unit can be added and a mathematical expression can 
be prepared to correlate the proxy information to the information required in the 
numerical model. The ArgusNE User's Guide provides the details of adding 
information layers and linking information layers to other information layers using 
mathematical expressions. Thus, the list of geospatial information layers created in 
the MODFLOW-96 preprocessor should be regarded as a rudimentary structure that 
can be adapted to the unique demands of each modeling project. By adding geospatial 
information layers, a seamless computing environment can be created for ground- 
water flow modeling within one application, rather than performing correlations 
with proxy information externally and importing the results.

Although geospatial information layers can be added, the geospatial 
information layers created by the MODFLOW-96 preprocessor should not be deleted or 
renamed manually. The names of the geospatial information layers created by the 
MODFLOW-96 preprocessor are needed to link the geospatial information to the finite- 
difference grid and export this information in a form that can be read by MODFLOW- 
96. If the geospatial information layers are deleted or changed, the data files created 
for MODFLOW-96 might be corrupted.

VISUALIZING GEOSPATIAL INFORMATION LINKED TO THE FINITE- 
DIFFERENCE GRID

It is advantageous to visualize the effect of the finite-difference discretization 
on the geospatial information that is used in the numerical model. For example, 
visualizing the geospatial information linked to the finite-difference grid may 
indicate if discretization is too coarse to capture the spatially varying nature of 
certain hydrologic properties. Visualization of geospatial information linked to the 
finite-difference grid is conducted in the layer MODFLOW FD Grid. Making this the 
active layer and using the cursor to click-hold the triangle to the right of the color 
legend in the tool palette opens a menu with the list of the parameters linked to the 
finite-difference grid. Moving the cursor to one of parameters on the list and 
releasing the mouse button will visualize the information in the selected parameter 
as it is linked to the finite-difference grid. The mathematical statements used to link 
the geospatial information to the finite-difference gird can be seen in the Layers 
dialog under the parameters linked to the layer MODFLOW FD Grid. In addition, the 
spatial information attributed to a finite-difference cell can be examined by doubling
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clicking on the cell in the layer MODFLOW FD Grid; a dialog box appears with a list 
of the parameter values linked to that finite-difference cell.

In the following, the geospatial information linked to the finite-difference 
grid by the MODFLOW-96 preprocessor is described. References to geologic units are 
denoted by [i], where the "i" denotes the sequence number of the geologic unit. 
Furthermore, geospatial information layers denoted by [i] indicate that a geospatial 
information layer of that type will be created for each geologic unit specified in the 
Geology dialog in the MODFLOW-96 Preprocessor.

Visualization of Topographic Information 

Elev Top Unit[i]

Selecting Elev Top Unit[i] evaluates by color the grid cell values from the 
layer Elevation Top Unit[i].

Elev Bot Unit[i]

Selecting Elev Bot Unit[i] evaluates by color the grid cell values from the 
layer Elevation Bottom Unit[i].

Thickness Unit[i]

Selecting Thickness Unit[i] evaluates by color the grid cell values from the 
difference between the layer Elevation Top Unit[i] and Elevation Bottom 
Unit[i].

Visualization of Hydrogeologic Information 

IBOUND Unit[i]

The IBOUND array in MODFLOW-96 defines the location of active cells, inactive 
cells and cells having a prescribed hydraulic head. Inactive cells are assigned a 
value of zero, active cells are assigned a value of one and cells having a prescribed 
head are assigned a value of negative one. Selecting IBOUND Unit[i] evaluates by 
color the grid cell values for the IBOUND array. The layers Added Inactive Area 
Unit[i] and Prescribed Head Unit[i] are used to define the parameter IBOUND 
Unit[i].

Initial Head Unit[i]

Selecting Initial Head Unit[i] evaluates by color the grid cell values from 
the layer Initial Head Unit[i].

Kx Unit[i]

Selecting Kx Unit[i] evaluates by color the grid cell values from the 
parameter Kx in the layer Hydraulic Conductivity Unit[i].

Kz Unit[i]

Selecting Kz Unit[i] evaluates by color the grid cell values from the 
parameter Kz in the layer Hydraulic Conductivity Unit[i].
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Sp.Yield Unitfi]

Selecting Sp_Yield Unit[i] evaluates by color the grid cell values from the 
layer Specific Yield Unit[i].

Sp_Storage Unit[i]

Selecting Sp_Storage Unit[i] evaluated by color the grid cell values from 
the layer Specific Storage Unit[i].

Wetting Unitfi]

Selecting Wetting Unit[i] evaluates by color the grid cell values of the 
product of the wetting threshold and the wetting flag parameters specified in the 
layer Wetting Threshold Unitfi].

Visualization of Fluid Stresses 

Recharge Elevation

Selecting Recharge Elevation evaluates by color the grid cell values of the 
parameter recharge elevation that appears in the layer Recharge. The recharge 
elevation is used only if the recharge option in the Stresses/Solvers dialog indicates 
that the application of the recharge is to be specified from the recharge elevation.

ET Surface Elevation

Selecting ET Surface Elevation evaluates by color the grid cell values of the 
parameter evapotranspiration surface specified in the layer Evapotranspiration.

Well Location Unit[i]

The wells specified in the layer Wells Unitfi] are visualized in Well 
Location Unitfi]. The grid cells with one or more wells are given a value of one; 
grid cells without wells are given a value of zero. If more than one well is located in a 
grid cell, the preprocessor for MODFLOW-96 will export information associated with 
each well individually for use in MODFLOW-96.

River Location Unitfi]

The grid cells occupied by line and area rivers from the layers Line River 
Unitfi] and Area River Unitfi] are visualized in River Location Unitfi]. The 
grid cells with one or more line or area rivers are given a value of one; grid cells 
without line or area rivers are given a value of zero. If more than one line or area 
river is located in a grid cell, the preprocessor for MODFLOW-96 will export 
information associated with each river individually for use in MODFLOW-96.

Drain Location Unitfi]

The grid cells occupied by line and area drains from the layers Line Drain 
Unit[i] and Area Drain Unit[i] are visualized in Drain Location Unitfi]. The 
grid cells with one or more line or area drains are given a value of one; grid cells 
without line or area drains are given a value of zero. If more than one line or area
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drain is located in a grid cell, the preprocessor for MODFLOW-96 will export 
information associated with each drain individually for use in MODFLOW-96.

Gen Head B Location Unit[i]

The grid cells occupied by point, line and area general-head boundary stresses 
from the layers Point Gen Head Boundary Unit[i], Line Gen Head Boundary 
Unit[i] and Area Gen Head Boundary Unit[i] are visualized in Gen Head B 
Location Unit[i]. The grid cells with one or more point, line or area general-head 
boundary stresses are given a value of one; grid cells without general-head boundary 
stresses are given a value of zero. If more than one general-head boundary stress is 
located in a grid cell, the preprocessor for MODFLOW-96 will export information 
associated with each individually for use in MODFLOW-96.

Adding Parameters Linked to the Finite-Difference Grid

The list of parameters linked to the finite-difference grid for visualization in 
the MODFLOW-96 preprocessor can be expanded according to the unique needs of 
each modeling project. The ArgusNE User's Guide provides the details of adding and 
linking parameters to the finite-difference grid. Thus, the list of parameters linked 
to the finite-difference grid for visualization as created in the MODFLOW-96 
preprocessor should be regarded as a rudimentary structure that can be adapted to 
the unique demands of each modeling project.

Although additional parameters can be linked to the finite-difference grid, it 
is not recommended that existing parameters linked to the finite-difference grid be 
deleted. Deleting parameters linked to the finite-difference grid would reduce the 
ability to visualize the effect of discretization on geospatial information used in 
MODFLOW-96 simulations.

CREATING DATA FILES AND EXECUTING MODFLOW-96

The file MODFLOW.MET in the ArgusPIE directory is the export template used by 
MFGUI_10.DLL to export and format the ASCII files needed to execute MODFLOW-96. 
The MODFLOW.MET file synthesizes the project information and geospatial 
information linked to the finite-difference grid and exports this information in a 
format that can be read by the executable version of MODFLOW-96. In addition, 
MODFLOW-96 can be executed from within ArgusNE and the hydraulic head and/or 
drawdown solutions from MODFLOW-96 can be visualized, thus, creating a seamless 
computing environment for ground-water simulations.

The ASCII files used to execute MODFLOW-96 are created from the MODFLOW FD 
Grid layer in ArgusNE. While in the MODFLOW FD Grid layer, the cursor is moved 
to the Export command in the File pull-down file menu. The Export command is a 
hierarchical menu, and within this hierarchical menu the Run MODFLOW 
command is chosen. A dialog box appears with two options, "Create MODFLOW Input 
Files" and "Create MODFLOW Input Files and Run MODFLOW." The first option only 
creates the ASCII files suitable for execution of MODFLOW-96; these files contain the 
simulation control information and the geospatial information linked to the finite- 
difference grid. The second option creates the ASCII files and then executes 
MODFLOW-96 from within ArgusNE, after which control is returned to ArgusNE. Also 
listed on this dialog box is an option to return to the MODFLOW-96 Preprocessor dialog 
boxes to edit or check the project information; clicking the Edit Parameters button 
returns to the MODFLOW-96 Preprocessor dialog boxes.
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Choosing either the "Create MODFLOW Input Files" or "Create MODFLOW Input 
Files and Run MODFLOW" option leads to a dialog box in which the directory needs to 
be specified for storing the files created for executing MODFLOW-96. The file name at 
the bottom of this dialog box can be ignored because the root name of the files to be 
created and the extensions for theses files are specified in the Output Files dialog box 
and in the export template. If the user wishes to run MODFLOW-96 from within 
ArgusNE, the directory containing the executable version of MODFLOW-96 should be 
chosen.

If it is desirable, the ASCII files created from ArgusNE for executing MODFLOW- 
96 can be viewed by using any text editor. It may be desirable to view and edit these 
files created for MODFLOW-96 if the user is familiar with the file structure and data 
input for MODFLOW-96 and only minor changes are needed for additional simulations. 
However, it is also possible and easier to make these changes in the MODFLOW-96 
Preprocessor dialog boxes and have the file exported again.

Files Created for MODFLOW-96 Simulations

The files that are created for executing MODFLOW-96 will depend on the stress 
packages and solver used in the simulation. The following is a list and explanation of 
file names that are created by the preprocessing PIE for MODFLOW-96. In the 
following, Rootname refers to the file name specified in the Output Files dialog box of 
the MODFLOW-96 Preprocessor.

modflow.bfis the "batch" file containing the "name" file for the MODFLOW-96 
simulation. Executing MODFLOW-96 from within ArgusNE executes MODFLOW-96 in a 
"batch" mode so that additional keyboard input is not needed. If it is desirable to 
execute MODFLOW-96 outside of ArgusNE, this "batch" file can be used to execute the 
files that have been created from within ArgusNE. Information about executing 
MODFLOW-96 in a "batch" mode are discussed in Harbaugh and McDonald (1996a). This 
file will always be created by the preprocessing PIE for MODFLOW-96.

Rootname is the "name" file containing the list of files and their unit numbers 
for the MODFLOW-96 simulation, where Rootname is the file name specified in the 
Output Files dialog box given in the MODFLOW-96 Preprocessor. This file will always 
be created by the preprocessing PIE for MODFLOW-96.

Rootname.BAS is the file containing information associated with the Basic 
package in MODFLOW-96. This file will always be created by the preprocessing PIE for 
MODFLOW-96.

Rootname.OC is the Output Control file for the MODFLOW-96 simulation. This file 
will always be created by the preprocessing PIE for MODFLOW-96.

Rootname.BCF is the file containing information for the Block-Centered Flow 
package. This file will always be created by the preprocessing PIE for MODFLOW-96.

Rootname.RCH is the file containing information for the Recharge package; 
this file is created only if the recharge package is chosen in the Stresses/Solvers 
dialog box.

Rootname.RIV is the file containing information for the River package; this 
file is created only if the river package is chosen in the Stresses/Solvers dialog box.
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Rootname.WEL is the file containing information for the Well package; this 
file is created only if the well package is chosen in the Stresses/Solvers dialog box.

Rootname.DRN is the file containing information for the Drain package; this 
file is created only if the drain package is chosen in the Stresses/Solvers dialog box.

Rootname.GHB is the file containing information for the General-Head 
Boundary package; this file is created only if the general-head boundary package is 
chosen in the Stresses/Solvers dialog box.

Rootname.EVT is the file containing information for the Evapotranspiration 
package; this file is created only if the evapotranspiration package is chosen in the 
Stresses/Solvers dialog box.

Rootname.SIP is the file containing information for the Strongly-implicit 
procedure package; this file is created only if SIP solver is chosen in the 
Stresses/Solvers dialog box.

Rootname.SOR is the file containing information for the Slice-successive 
overtaxation package; this file is created only if the SOR solver is chosen in the 
Stresses/Solvers dialog box.

Rootname.PCG is the file containing information for the preconditioned 
conjugate-gradient package; this file is created only if the PCG solver is chosen in 
the Stresses/Solvers dialog box.

Rootname.DE4 is the file containing information for the direct solution 
package with alternating diagonal ordering package; this file is created only if the 
DE4 solver is chosen in the Stresses/Solvers dialog box.

Files Created by Executing MODFLOW-96

The files that are optionally created by executing MODFLOW-96 are defined in 
the Output Files dialog in the MODFLOW-96 Preprocessor. In addition, the MODFLOW-96 
listing file, given the name Rootname.LST, will always be generated by MODFLOW-96. 
The following is a list and explanation of file names that are created by executing 
MODFLOW-96 if the preprocessing PIE discussed in this report is being used. In the 
following, Rootname refers to the file name specified in the Output Files dialog box.

Rootname.LST is the MODFLOW-96 listing file containing general information 
about the simulation. This file is always created by MODFLOW-96.

Rootname.FHD is the formatted text file containing the hydraulic head 
solutions for the time steps specified in the Output Controls dialog. The hydraulic 
head solution for all layers in the simulation are exported into this file. This file will 
be created by MODFLOW-96 only if formatted text files for the hydraulic head have 
been specified in the Output Files dialog. The postprocessing visualization of 
hydraulic head that is described in this report uses this file.

Rootname.FDN is the formatted text file containing the drawdown solutions for 
the time steps specified in the Output Controls dialog. The drawdown solution for all 
layers in the simulation are exported into this file. This file will be created by 
MODFLOW-96 only if formatted text files for the drawdown have been specified in the
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Output Files dialog. The postprocessing visualization drawdown that is described in 
this report uses this file.

Rootname.BHD is the file containing the hydraulic head solutions written in a 
binary format for the time steps specified in the Output Controls dialog. The 
hydraulic head solution for all layers in the simulation are exported into this file. 
This file will be created by MODFLOW-96 only if a binary file for the hydraulic head 
solution has been specified in the Output Files dialog.

Rootname.BDN is the file containing the drawdown solutions written in a 
binary format for the time steps specified in the Output Controls dialog. The 
drawdown solution for all layers in the simulation are exported into this file. This file 
will be created by MODFLOW-96 only if a binary file for the drawdown solution has 
been specified in the Output Files dialog.

Rootname.BUD is the file of cell-by-cell flows from the Block-Centered Flow 
package, if it is specified in the Output Files dialog that the cell-by-cell flow from the 
Block-Centered Flow package are to be exported. Furthermore, if in the Output Files 
dialog, it is specified that all cell-by-cell flows from all fluid stresses are to be 
exported into a single file, the cell-by-cell flows from the stresses marked in the 
Output Files dialog will be exported into this file. This file is created in a binary 
format.

Rootname.BWE is the file of cell-by-cell flows from the well package, if it is 
specified in the Output Files dialog that cell-by-cell flows from the well package are 
to be exported, and the export of this information is to be placed in a separate file. 
This file is created in a binary format.

Rootname.BRC is the file of cell-by-cell flows from the recharge package, if it 
is specified in the Output Files dialog that cell-by-cell flows from the recharge 
package are to be exported, and the export of this information is to be placed in a 
separate file. This file is created in a binary format.

Rootname.BDR is the file of cell-by-cell flows from the drain package, if it is 
specified in the Output Files dialog that cell-by-cell flows from the drain package are 
to be exported, and the export of this information is to be placed in a separate file. 
This file is created in a binary format.

Rootname.BRI is the file of cell-by-cell flows from the river package, if it is 
specified in the Output Files dialog that cell-by-cell flows from the river package are 
to be exported, and the export of this information is to be placed in a separate file. 
This file is created in a binary format.

Rootname.BEVis the file of cell-by-cell flows from the evapotranspiration 
package, if it is specified in the Output Files dialog that cell-by-cell flows from the 
evapotranspiration package are to be exported, and the export of this information is 
to be placed in a separate file. This file is created in a binary format.

Rootname.BGH is the file of cell-by-cell flows from the general-head boundary 
package, if it is specified in the Output Files dialog that cell-by-cell flows from the 
general-head boundary package are to be exported, and the export of this 
information is to be placed in a separate file. This file is created in a binary format.
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VISUALIZING HYDRAULIC HEAD AND DRAWDOWN SOLUTIONS FROM
MODFLOW-96

The quick visualization of model results is important in facilitating the 
modeling process so that changes in project information and geospatial information 
can be made and additional simulation can be conducted with minimum delay. For 
this purpose, a postprocessing PIE has been developed for MODFLOW-96 simulation 
results that have used the preprocessing PIE for MODFLOW-96 in the ArgusNE 
application. The postprocessing PIE uses the formatted text files for hydraulic head 
and drawdown generated by executing MODFLOW-96. These files are given the names, 
Rootname.FHD and Rootname.FDN, where Rootname is the file name specified in the 
Output Files dialog.

The postprocessing PIE for MODFLOW-96 is launched from within the ArgusNE 
application. With the file MFPOST10.DLL in the ArgusPIE directory, launching 
ArgusNE will automatically load the PIE needed to launch the postprocessing 
interface for MODFLOW-96. The postprocessing PIE for MODFLOW-96 uses information 
from the layer MODFLOW FD Grid. Therefore, it is necessary to have a project file 
open with the finite-difference grid that was used to generate the files Rootname.FHD 
and Rootname.FDN. If changes have been made in the geospatial information without 
changing the finite-difference grid, then multiple files with the extension FHD and 
FDN can be visualized using the same project file even though the current geospatial 
information has been altered. However, if changes are made in the finite-difference 
discretization in the layer MODFLOW FD Grid, and the visualization of simulations 
made with previous finite-difference grids is desired, the user should save the 
project file before making changes in the finite-difference discretization using the 
Save As... command in the File pull-down menu.

Launching the Postprocessor

To execute the post processing PIE, the Import command in the File menu is 
used. The Import command yields a hierarchical menu of import options. Choosing 
the option MODFLOW PostProc launches the postprocessing PIE and causes a file 
dialog to appear. Files with the extensions FHD and FDN can be chosen from this 
dialog, as long as these files were created from MODFLOW-96 simulations that used the 
finite-difference grid in the layer MODFLOW FD Grid of the current project file.

The postprocessing PIE reads the file that is chosen and a dialog appears 
giving a listing of solutions for hydraulic head or drawdown (Figure 16). For each 
model layer that is contained in the file, the stress period, the time step and the data 
type (hydraulic head or drawdown) is also specified; in the dialog, stress period is 
abbreviated by SP and time step is abbreviated by S. The cursor is used to highlight 
one or more of the solutions for model layers by clicking on one or more rows in the 
dialog. Clicking OK causes another dialog to appear where the type of postprocessing 
visualization is to be specified (Figure 17). The types of postprocessing methods are 
Contour Map, Color Map, 3D Surface Map and Cross Section. Clicking on one of these 
postprocessing methods and clicking OK results in two layers being added to the 
project file. These layers are titled MODFLOW Data and MODFLOW Post 
Processing Charts. These layers can be seen in the list of layers in the floating 
layers. The layer MODFLOW Data is an ArgusNE data layer and the layer MODFLOW 
Post Processing Charts is an ArgusNE maps layer. Making the layer MODFLOW 
Post Processing Charts the active layer shows the postprocessing objects that 
have been created; it may be necessary to hide other layers in order to clearly see the 
postprocessing charts that were created.
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Available Data

Please Select a Data Matrix:

Layer:1 SRI S:1 TyperHEAD 
Layer:2 SRI S:1 Type:HEAD 
Layer:3 SRI S:l Type:HEAD

Figure 16. Data dialog for MODFLOW-96 postprocessor.

Chart Types

Please Select chart type:

Contour Map 
Color Map 
3D Surface 
Cross Section

Figure 17. Visualization dialog for MODFLOW-96 postprocessor.

The layer MODFLOW Data contains the solutions that have been imported for 
visualization. This data appears as discrete points located at the center of the grid 
cells. The solutions in this data layer can be used for purposes other than the 
visualization that appears in the layer MODFLOW Post Processing Charts. For 
example, the solutions in the layer MODFLOW Data can be compared with measured 
hydraulic heads or drawdowns, if such information has been entered into geospatial 
information layers. It is then possible to create and visualize a new parameter linked
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to the finite-difference grid which gives the difference between the measured 
hydraulic head and the hydraulic head solutions.

In the following, a brief description of the postprocessing methods is given. 
Additional information on creating and modifying the appearance of postprocessing 
objects in Argus NE is given in the ArgusNE User's Guide.

Contour Map

Selecting the contour map option produces a contour map of the hydraulic 
head or drawdown in the selected layers for the selected time steps in the selected 
stress periods. If only one layer is selected, the hydraulic head or drawdown contour 
map will overlay the finite-difference grid. If more than layer is selected, then the 
selected contour maps will be scaled and placed in the layer MODFLOW Post 
Processing Charts.

Clicking on a postprocessing object in the layer MODFLOW Post Processing 
Charts will bring up a dialog box that can be used to alter the appearance of the 
contour map. Additional information on editing the appearance of contour maps can 
be found in the ArgusNE User's Guide.

Color Map

Selecting the color map option produces a colorized interpolation of the 
hydraulic head or drawdown in the selected layers for the selected time steps in the 
selected stress periods. If only one layer is selected, the hydraulic head or drawdown 
color map will overlay the finite-difference grid. If more than layer is selected, then 
the selected contour maps will be scaled and placed in the layer MODFLOW Post 
Processing Charts.

Clicking on a postprocessing object in the layer MODFLOW Post Processing 
Charts will bring up a dialog box that can be used to alter the appearance of the 
color map. Additional information on editing the appearance of color maps can be 
found in the ArgusNE User's Guide.

Three-Dimensional Surface Map

Selecting the three-dimensional surface map option produces a colorized 
three-dimensional perspective map of the hydraulic head or drawdown in the 
selected layers for the selected time steps in the selected stress periods.

Clicking on a postprocessing object in the layer MODFLOW Post Processing 
Charts will bring up a dialog box that can be used to alter the appearance of the 
three-dimensional surface map. Additional information on editing the appearance of 
surface maps can be found in the ArgusNE User's Guide.

Cross Section

Selecting the cross-section option produces a plot of the hydraulic head or 
drawdown as a function of distance along a line through the modeled domain. The 
hydraulic head or drawdown from more than one layer can be included on the cross- 
section by choosing more than one layer in the Data dialog for the MODFLOW-96 
postprocessor. The orientation of the line and other attributes of the plot of the cross
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section can be adjusted by double clicking on the postprocessing object. Additional 
information on editing the appearance of cross-sectional plots can be found in the 
ArgusNE User's Guide.
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